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RESUMEN
La degradacion por pérdida de suelo ocasionada por diferentes factores atribuidos a
la accion humana, la ha hecho un problema medioambiental que no solo aqueja a
México sino a todo el mundo, lo que a su vez se ha traducido en la reduccion de la
productividad de los ecosistemas. En respuesta a ello, a través de los afios se han
desarrollado una serie de formas de evaluacion de la erosion hidrica, que se han
mejorado mediante su integracion en medios de una era digital que la hacen mas facil
de estimar (debido a su gran cantidad de datos), como lo es la aplicacién de la EUPSR
en softwares como ArcGIS. Ante la situacidn, el objetivo del presente trabajo fue
determinar el riesgo potencial y actual a la erosién hidrica del suelo en el municipio de
Santiago Tulantepec, Hgo., a través de la EUPSR integrada a los SIG para identificar
las zonas de mayor riesgo a la pérdida de suelo. Las variables evaluadas estuvieron
enfocadas a determinar cada uno de los factores que conforman el modelo de la
EUPSR, la cual integra datos relacionados a la lluvia, tipo de suelo, topografia del
terreno, cobertura del suelo y la presencia de obras de conservacion, que a su vez
fueron aplicados en el software ArcGIS 10.8. De este modo, los resultados arrojaron
datos de “erosividad muy baja” (R) de 1,422.24 a los 1,804.52 MJ mm ha! h! afio?,
combinados con erodabilidad del suelo (K) de 0.013 a 0.079 Mg ha h ha’* MJ** mm1,
en pendientes de 0 a 79% con valores de LS de 0 a mas de 50, bajo coberturas
vegetales (C) estimadas entre 0.001 y 1 y con la presencia de obras (P) bajo un rango
de 0.40 y 1. Con ello, se posibilitd el calculo de la erosién hidrica actual al integrar
todos los factores de la EUPSR, dominada por un 83.11% de la superficie y bajo la
categoria “baja” que indic6 pérdidas menores a 10 Mg ha afio™, caso contrario a lo
encontrado para la erosion hidrica potencial y segun las categorias propuestas para
este estudio se presentdé en mayor distribucion bajo la denominacion “extrema” con
32.01% de la superficie total, la cual a su vez tomd los valores superiores en aquellas
areas donde coincidieron los valores mas altos de precipitaciébn con topografia
accidentada. Se concluy6 que la combinacion EUPSR-SIG resulta una alternativa
viable para tener un panorama general de las condiciones de erosion en el area de

estudio.



ABSTRACT
Degradation due to soil loss caused by different factors attributed to human action, has
made it an environmental problem that not only affects Mexico but the whole world,
which in turn has resulted in the reduction of ecosystem productivity. In response to
this, over the years a series of ways of evaluating water erosion have been developed,
which have been improved by integrating them into the means of a digital era that make
it easier to estimate (due to its large amount of data), such as the application of the
RUSLE in software such as ArcGIS. Given this situation, the objective of this study
was to determine the potential and current risk to soil water erosion in the municipality
of Santiago Tulantepec, Hgo. through the RUSLE integrated to GIS to identify the
areas of greatest risk to soil loss. The variables evaluated were focused on determining
each of the factors that make up the RUSLE model, which integrates data related to
rainfall, soil unit, topography, land cover and the conservation works, which in turn
were applied in ArcGIS 10.8 software. Thus, the results yielded "very low erosivity" (R)
data from 1,422.24 to 1,804.52 MJ mm ha* h't yrl, combined with soil erodibility (K)
from 0.013 to 0. 079 Mg ha h ha* MJ* mm-?, on slopes from 0 to 79% with LS values
from O to more than 50, under vegetation covers (C) estimated between 0.001 and 1
and with the presence of soil conservation works (P) under a range of 0.40 and 1. With
this, it was possible to calculate the current water erosion by integrating all the factors
of the RUSLE, dominated by 83.11% of the surface and under the category "low" which
indicated losses of less than 10 Mg ha! yr! contrary to what was found for potential
water erosion and according to the categories proposed for this study, it was presented
in greater distribution under the denomination "extreme" with 32.01% of the total
surface, which in turn took the highest values in those areas where the highest values
of precipitation coincided with rugged topography. We concluded that the RUSLE-GIS
combination is a viable alternative for obtaining a general overview of erosion

conditions in the study area.



1. INTRODUCCION

En todo el mundo, los cambios como: el crecimiento poblacional, la urbanizacion, la
desertificacién, la pérdida de biodiversidad, la escasez de agua, la degradacion de la
tierra, etc., han afectado negativamente y de manera rapida el medio ambiente (UN
Environment, 2019). De este modo, la pérdida de suelo de las superficies terrestres
por erosion estd muy extendida en todo el mundo lo que ocasiona de forma adversa
afectaciones en la productividad de los ecosistemas naturales, como en la agricultura,
los bosques y pastizales, disminuyendo su calidad y dando lugar a que a través de
muchos aflos se den cambios infligidos en los suelos por erosion inducida por el
hombre, originando que tierras valiosas que antes eran productivas se vuelvan
improductivas y, a menudo, con el tiempo sean abandonadas. Ademas, a esto se le
agrega el dafo provocado a la diversidad de plantas, animales y microbios en el suelo
(Pimentel, 2006).

La degradacién por pérdida de suelo, que supone una pérdida fisica de las particulas
del suelo debido a procesos erosivos como la lluvia o el viento, donde, la primera hace
referencia a la pérdida gradual de material por el impacto de las gotas de lluvia sobre
un suelo desnudo, provocando la liberacién de particulas que son transportadas
vertiente abajo (erosion hidrica) y la segunda refiere a la pérdida de particulas de suelo
a través del transporte realizado por accién del viento (erosion edlica) y depositadas

en otro lugar, por deflacién o abrasion (Porta et al., 2014).

“Se calcula que el 95% de los alimentos se produce directa o indirectamente en los
suelos” (FAO, 2015), mientras que el resto proviene de los océanos y otros sistemas
acuaticos, de ahi la importancia de mantener la productividad y la calidad de los
suelos, que basicamente son el pilar mundial para la producciéon de alimentos
(Pimentel, 2006).

Lamentablemente, el suelo ha sido hasta el presente un patrimonio subestimado, un
recurso que se ha dilapidado, y cuya pérdida, de continuar a los ritmos actuales, pone
en peligro la viabilidad nacional, dandole poca atencion y regulacion de uso, reflejando
altos niveles de degradacion con repercusiones sociales, economicas y ambientales

graves, pero cabalmente poco valoradas (CONAFOR, 2004).



A través de los afios un sin numero de investigaciones han estudiado y comprobado
gue los factores mas importantes que influyen en la erosion hidrica del suelo son: el
clima, la topografia y las caracteristicas de los diferentes suelos. Para cuantificar la
pérdida de suelo, se han desarrollado con los afios diferentes modelos matematicos
gue permiten saber de manera directa o indirecta la cantidad de suelo que se pierde
bajo diferentes condiciones presentadas en los sitios de estudio, entre ellos destaca

la Ecuacion Universal de Pérdida de Suelo (Dumas-Salazar, 2012).

La aparicidbn de un gran niumero de modelos de erosion del suelo ha permitido el
estudio de este fendmeno, especialmente con fines de conservacion con un nivel de
precision efectivo y aceptable. Ademas de facilitar su estimacion, permiten desarrollar
planes de manejo éptimos bajo modelos como la EUPS, EUPSR, WEPP, SEMMED,
ANSWERS, LISEM, EUROSEM, SWAT, SWRRB, AGNPS, etc., y ser utilizados bajo
una escala regional (Ahmad et al., 2017). Como mencionan Barrena-Gonzélez et al.
(2020), en la actualidad se pueden incorporar a los SIG una gran variedad de modelos
paramétricos que permitan estudiar la pérdida de suelo.

En los ultimos afios el uso de estas nuevas tecnologias de la informacién (sistemas
de informacién geografica y la teledeteccidn), como herramientas en la realizacion de
estudios de cartografia de riesgos de erosién han permitido consolidarse como
alternativa a la hora de realizar una planificacion sostenible, logrando un andlisis

territorial y de seguimiento temporal a este fendmeno (Dumas-Salazar, 2012).

Afortunadamente los SIG son una tecnologia adecuada para el manejo e integracion
de informacion espacial y demas elementos de un componente geografico que permite
tomar decisiones, ademas de posibilitar realizar gran variedad de modelos
cartograficos en lapsos de tiempo cortos y con inversiones econémicas menores, asi
como generar la posibilidad de aplicar diferentes escenarios sin generar mayores

complicaciones y/o costos (Cordero-Rebolledo, 2022).



2. MARCO TEORICO

2.1 SUELO

La Sociedad Americana de la Ciencia del Suelo define al suelo como el material
mineral u organico no consolidado en la superficie de la tierra que ha sido sometido y
muestra los efectos de los factores genéticos y ambientales de: clima (incluyendo los
efectos del agua y la temperatura), y los macro y microorganismos, condicionados por
el relieve que actian sobre el material parental durante un periodo de tiempo (SSSA,
2008).

Gardi et al. (2014), afirmaron lo siguiente:

El suelo es una formacion natural que se halla en la interseccion de la litésfera,
hidrésfera, biosfera y atmosfera. Resulta de la accion conjunta de procesos
fisicos, quimicos y biolodgicos (meteorizacion) sobre el medio original (la roca
madre). Dichos procesos transforman el material inicial hasta darle una
morfologia y propiedades caracteristicas. El suelo estd compuesto por
elementos minerales y organicos en estado sélido, liquido y gaseoso, los cuales
se interrelacionan dando lugar a distintos niveles de organizacion con
variaciones tanto espaciales (verticales y laterales) como temporales (horarias,
estacionales, centenarias y hasta milenarias). Es un sistema complejo en el que
suceden de manera continua procesos quimicos, fisicos y bioldgicos. La ciencia
que estudia la composicién y naturaleza del suelo en su relacion con las plantas
y el entorno que le rodea se denomina Edafologia, mientras que la Pedologia
se ocupa del estudio de su formacion, clasificacion, morfologia y taxonomia,

ademas de la interaccion con el resto de los factores geograficos.

Desde el punto de vista edafolégico, el suelo, es un ente natural
organizado e independiente, con constituyentes, propiedades y génesis que
son el resultado de la actuacién de una serie de factores activos (clima,
organismos Vivos) que actian sobre los factores pasivos (la roca madre y el

relieve), independientemente del tiempo transcurrido. (p. 12).



2.2 FACTORES DE FORMACION DEL SUELO
De acuerdo con Jenny (1941) en su obra Factores formadores del suelo (Factors of
Soil Formation) citado por Gardi et al. (2014), las propiedades de los suelos resultan

de la interaccion de cinco factores importantes, expresada en la siguiente ecuacion:
suelo = f (roca madre, clima, organismos vivos, topografia, tiempo)

Material parental/Roca madre: Esta representado generalmente por la roca madre o
por un material transportado y depositado. Se compone de minerales, los cuales
pueden estar consolidados o no, que sufren la accién de otros factores a lo largo del
tiempo y en parte sometidos a meteorizacion fisica, quimica y/o biolégica. Los rasgos
mas importantes originados por este factor son: composicion mineralogica,
granulometria y permeabilidad de los suelos. Las rocas de tipo ignea (granito,
basalto), sedimentarias (dolomitas, roca caliza) y metamorficas (gneis, marmol) son

las principales en su clasificacion.

Relieve: Es uno de los aspectos fundamentales en la formacién de suelos. Desde el
punto de vista edafico, los elementos del relieve mas importantes son la inclinacién y
la longitud de las laderas, la posicion fisiogréfica y la orientacion. Conjuntamente con

el clima, determina las caracteristicas de los suelos y la vegetacion.

Clima: La accion del clima en la formacién del suelo resulta ser decisivo y
principalmente tiene que ver con el aporte de agua al suelo y la temperatura. Ambos
factores (humedad y temperatura) influyen en los procesos basicos que dan origen a
la formacion de suelos. Influye también en otros factores como los biodticos y el relieve
y en accion conjunta condiciona el contenido de materia organica y su grado de

evolucion en un suelo dado.

Organismos vivos: Desde la microfauna hasta la vegetacibn se consideran
formadores de suelo, al participar como fuente de materia organica y agentes directos
de procesos edafogenéticos (transforman fisica, quimica y biolégicamente el suelo).
Estos procesos estan relacionados directamente con la cantidad y caracteristicas de

los organismos vivos.



Tiempo: El periodo necesario para que el material parental evolucione es muy largo,
ya gue el ritmo de los procesos edafogenéticos es extraordinariamente lento (entre
0.001 y 1 mm/afio), aunque en climas célidos y hiumedos es mas rapido en
comparacién con otros climas. La velocidad de formacion de los suelos disminuye con

el tiempo hasta su estabilizacion.

2.3 FUNCIONES DEL SUELO

El suelo ha sido un ente que a pesar de su aporte a la vida en la tierra pocas veces se
aprecia como tal, por tal motivo es importante resaltar algunas de las funciones
ecosistémicas y relacionadas con la actividad humana. De acuerdo con Burbano-
Orjuela (2016), algunas de las funciones y servicios mas importantes de los suelos

son:

Produccién de alimentos y biomasa. Sirve como soporte y suministro de nutrientes
para las plantas a fin de producir alimentos y biomasa en general. Teniendo como
dato que, del suelo depende en forma directa o indirecta mas del 95% de la produccion

mundial de alimentos.

Ciclos biogeoquimicos. Por su ocurrencia en la naturaleza y bajo una posicion
central e insustituible en el suelo al dar paso continuo de los sistemas vivos del planeta
a otros que no lo son, se convierten en mecanismos indispensables para que haya
condiciones estables en el planeta y para que se dé la vida, al involucrar elementos

vitales como carbono, nitrégeno, fésforo, azufre, entre otros.

Almacenamiento o fijacién de carbono. El suelo es el mayor sumidero de carbono
en la naturaleza (el carbono almacenado como materia organica en el primer metro
de suelo, es una y media veces superior al acumulado en la vegetacion). La fijacion
del carbono en el suelo, comunmente mal acufiado este proceso como “secuestro de
carbono” o “captura de carbono”, impide que el CO2 vaya a la atmdsfera, al ser este
es uno de los gases de efecto invernadero que contribuyen con el cambio climatico

global.

Almacenamiento y filtracién de agua. El suelo es el medio de captacién, infiltracién

y almacenamiento del agua en el ambito del ciclo hidroldgico y permite asi la recarga



tan importante de los acuiferos, ademas influye en su calidad, al amortiguar y atrapar

ciertos contaminantes e impide que estos lleguen a las reservas de agua.

Soporte de las actividades humanas y fuente de materias primas. Sobre el suelo
se realizan una gran cantidad de actividades industriales, permite el habilitamiento de
zonas residenciales y de infraestructura turistica, se construyen carreteras y otras
obras de tipo civil. También, suele ser un suministro importante de materias primas de
amplio uso como: turba, grava, arena, arcilla o rocas, utilizadas en diferentes procesos

productivos de relevancia econémica.

Reserva de biodiversidad. El suelo es una de las reservas mas importantes de
biodiversidad, no solo por el enorme nimero de organismos que viven en su superficie
sino también, al interior del mismo; la abundancia encontrada es tal, que se cree,
supera la establecida por encima de este cuerpo natural. Aunque es de importancia
mencionar que, los servicios ecosistémicos que presta el suelo, dependen de las

complejas comunidades de organismos presentes en este medio.

Depdsito del patrimonio geoldgico y arqueolégico. El suelo resulta ser el soporte
mas importante de gran parte de los restos que dan cuenta de la herencia humana y
de la historia ambiental reciente de la Tierra. La preservacion del patrimonio geoldgico
y arqueoldgico va a depender principalmente de los procesos de formacién y
degradacion del suelo y va a estar estrechamente relacionada con los efectos de: la
actividad biolégica que se desarrolle en él, asi como de la circulacién del agua que
ocurren dentro y fuera de él, ademas de las acciones humanas de intervencion en el

suelo, por mencionar algunos.

Entorno fisico y cultural para la humanidad. El suelo, ademas de servir de base a
las actividades humanas es, asimismo, un elemento del paisaje y del patrimonio
cultural. El suelo permite que los seres humanos tengan a su disposicion alimentos,
abrigo, espacio y habitat para desarrollarse como personas en ascenso, y de muchos

otros elementos para su existencia.



2.4 COMPONENTES DEL SUELO

FAO (1996), sefiala que el suelo estd compuesto por minerales, materia organica,

diminutos organismos vegetales y animales, aire y agua.

Los minerales provienen principalmente de la roca madre.

La materia organica es el producto de la descomposicion de vegetales y
animales muertos y puede almacenar gran cantidad de agua y es rica en

minerales.

Los microorganismos son de dos tipos: los que desplazan la materia organica
(insectos y lombrices) y los que la descomponen liberando los nutrientes

(hongos, bacterias).

El agua y aire ocupan poros, espacios entre las particulas de suelo que se
producen por las irregularidades de su forma y tamafio.

Las proporciones ocupadas por los componentes del suelo son: minerales (45%),
materia organica (0.5-5%), agua (20-30%) y aire (20-30%) (INECC, 2007a).

2.5

IMPORTANCIA DEL RECURSO SUELO

La FAO (2015) menciona que:

Los suelos son un recurso clave para mantener el bienestar humano, ademas
de ser fundamental en la creaciébn de una serie de productos y servicios

ecosistémicos esenciales como:

Produccion de alimentos, fibras, combustibles y medicamentos, al ser la base
de estos.

Los suelos son el medio de absorcion, almacenamiento, alteracion, purificacion
y liberacion de agua, que permiten el crecimiento de las plantas y el
abastecimiento hidrico.

Interactian con la atmosfera a través de la absorcién y emision de gases
(di6xido de carbono, metano, vapor de agua, por mencionar algunos) y polvo.
Constituyen la mayor reserva de C organico terrestre (resultan poseer mas del

doble del C organico almacenado en la vegetacion que los suelos soportan).



e Regulan los ciclos del C, oxigeno y los nutrientes de las plantas (N, P, K, Ca,
Mg, entre otros.).

o Habitat importante de diversos animales y organismos (como bacterias y
hongos) y consecuentemente mantiene la actividad bioldgica, la diversidad y la
productividad.

« Habitat y medio importante para la dispersion de semillas y la diseminacion del
patrimonio genético.

« Medio que amortigua, filtra y modera el ciclo del agua.

o Plataforma que permite los asentamientos urbanos, y uso como material de

construccion.

2.6 CLASIFICACION DE LOS SUELOS

Exceptuando los glaciares, los cuerpos de agua y las zonas urbanas, el suelo cubre
de manera continua la superficie terrestre en una variada gama de tipos, a pesar de
esta gran variaciéon, no se posee de un sistema de clasificacién universal y los que
son utilizados por la mayoria de los paises dependen, en gran medida, de la inversion
gue se aplica en el levantamiento de los suelos para su determinacion. Esta situacion
complica una comparacion internacional, sin embargo, existen un par de intentos para
armonizar la forma de clasificar y caracterizar los suelos: la taxonomia de los suelos
de la USDAy la Base Referencial Mundial del Recurso Suelo de la FAO (SEMARNAT,
2016).

La WRB retoma las caracteristicas minimas indispensables de los suelos y es menos
costosa, ademas su objetivo no es sustituir, sino facilitar la comunicacién internacional
a través de un lenguaje que incorpore términos edaficos comunes. Es por ello que, de
acuerdo a la clasificacion mas actualizada se incluyen 32 unidades de suelo, basadas
en las diferencias que existen en sus caracteristicas diagnosticas (horizontes,
propiedades fisicas, quimicas y biologicas) y la relacion con sus factores formadores

(roca madre, clima, topografia, biota y tiempo) (WRB, 2015).

El sistema de clasificacion edafica utilizado en México de manera oficial por el Instituto
Nacional de Estadistica y Geografia es el de la WRB, el cual fue adaptado a las



condiciones ambientales del pais y reportado desde la primera version de las cartas
edafologicas del INEGI (SEMARNAT, 2016).

Segun datos del INEGI, en México existen 25 de las 32 unidades de suelo de la WRB
y a pesar de que seis grupos cubren en su conjunto mas del 80% de la superficie
nacional, la diversidad edafica esta determinada por los 19 grupos restantes
encontrados en diferentes microrelieves, microclimas y diferentes tipos de vegetacion
(Cruz et al., 2007). Las unidades de suelo dominantes son: Leptosoles (52.5 millones
de ha), Regosoles (27 millones de ha), Feozems (22.5 millones de ha), Calcisoles
(19.6 millones de ha), Luvisoles (17.7 millones de ha) y Vertisoles (16.5 millones de
ha) y el resto de los suelos (19 unidades) en total cubren alrededor de 36 millones de
hectéreas (INEGI, 2007).

2.7 DEGRADACION DE LOS SUELOS

La FAO (2015) define a la degradacion del suelo como:

‘La reduccion de su capacidad para proporcionar bienes y servicios
ecosistémicos y garantizar sus funciones durante un periodo de tiempo para los
beneficiarios de los mismos. La degradacién del suelo se manifiesta de diversas
formas: erosion del suelo, salinizacion, agotamiento de los nutrientes, pérdida
de la biodiversidad del suelo, contaminacion, compactacion, pérdida de materia

orgéanica, o sellado del suelo, entre otras”.

Actualmente, la degradacion ambiental es reconocida como una de las principales
amenazas que no solo afectan al planeta, sino que también comprometen la existencia
de miles de especies, incluyendo la humana y que de acuerdo a las tendencias hacia
el deterioro ambiental es necesario el monitoreo de los recursos naturales para

identificar las areas con condiciones criticas de deterioro (Pérez-Vega et al., 2020).

La degradacion de los suelos ocurre en respuesta a multiples factores ambientales
como: clima (precipitacion, evapotranspiracion, temperatura, humedad), paisaje
(suelos, geomorfologia, vegetacién, geologia, hidrologia) usos de suelo (sistemas de
produccion, deforestacion, sobrepastoreo) y socioecondmicos (densidad de

poblacion, sistemas de tenencia de la tierra, politicas publicas, mercado), es



importante indicar que rara vez es un solo factor el que desencadena el problema de
degradacion, y ademas en practicamente todos, el factor preponderante recae en las

actividades humanas.

Las actividades humanas mas destacadas que inducen la degradaciéon de suelos se
encuentran: las actividades agropecuarias, la deforestacion, el manejo inadecuado de
los recursos forestales, el sobrepastoreo y los sistemas de produccion agricola
(INECC, 2007b).

“La degradacion de los suelos puede conducir a una situacion irreversible, la
desertificacidon. Esta consiste en la reduccion o destruccion del potencial biolégico de
la tierra que puede llevar a la creacion de condiciones analogas a las de un desierto
natural” (INECC, 2007c).

2.8 EROSION
Kirkby & Morgan (1984) citados por Loredo-Osti (2005), definen la erosién como “un
proceso fisico que consiste en el desprendimiento, transporte y deposicion de las

particulas del suelo por los agentes erosivos”.

Si este proceso se lleva a cabo en condiciones naturales se denomina erosion
geoldgica, pudiendo ser considerada en tal caso como una forma mas de
conformacion del relieve, pero si la tasa de erosion se incrementa por las actividades
humanas (modificacion de la superficie terrestre, manipulacién de la capa arable y
cobertura vegetal en los terrenos agricolas o deforestacion), se manifiesta como

erosion acelerada o inducida (Loredo-Osti, 2005).

La erosion potencial es aquella generada en un suelo que se encuentra totalmente
desprotegido de una cubierta vegetal y alterado en su maximo nivel por medio de
implementos mecanicos, de este modo se considera como el nivel maximo de erosion

gue se puede esperar en un area determinada (Wischmeier & Smith, 1978).

La erosidén actual es aquella que se esta generando en el momento de la evaluacién,
originada por efectos del sistema de produccién que se esté ejecutando en el area
evaluada, o con la cobertura vegetal presente actual (en el caso de no ser sitio
cultivado) (Wischmeier & Smith, 1978).



De acuerdo al agente causante de la erosidbn que puede ser agua o viento, se
diferencian dos tipos de erosion: hidrica y eolica. La erosion hidrica se presenta
cuando el agua de lluvia desprende las particulas de los agregados en la superficie
del suelo y estos son arrastrados a través de un escurrimiento superficial (Loredo-Osti
et al., 2007).

Segun Suéarez de Castro (1980) citado por Rodriguez-Cristaldo (2012), la erosion

hidrica se puede presentar de las siguientes formas:

Laminar: “Se debe especialmente al desprendimiento mas o menos uniforme de
particulas en toda un area, ocasionado por el impacto de las gotas de lluvia sobre un

suelo mal protegido y al arrastre posterior de dichas particulas por la escorrentia”.

En surcos: “Ocurre cuando por irregularidades en la pendiente del terreno, la
escorrentia se encuentra en algunos sitios del paisaje hasta adquirir volumen vy
velocidad suficiente para hacer otros cortes y formar canaliculos que se destacan en

el terreno”.

En céarcavas: “Se presenta cuando hay una gran concentraciéon de la escorrentia en
determinadas zonas del terreno y que ocasiona afio tras afio la ampliacién de los

surcos formados por la accidén de esas corrientes de gran volumen y velocidad”.

2.9 MODELOS DE EROSION

Las investigaciones aplicadas sobre el proceso de erosion han tenido grandes
avances importantes, esto gracias a la incorporaciéon de modelos de simulacion
numeérica por computador. Los modelos de erosion permiten evaluar espacialmente la
ocurrencia de los procesos que dan origen a la erosion, analizar su evolucion a traves
del tiempo, asi como simular aquellos efectos de cambios en las variables del climay
paisaje. Los distintos modelos existentes se diferencian en aspectos importantes de
cara a su aplicacion como: la naturaleza de los procesos que incluyen, su
formalizacibn matematica, la representacion espacial y temporal, los requerimientos
de informacion y de tiempo de procesamiento a través de la computacién, entre otros.

Y algo muy importante, difieren en el tipo de publico al que van orientados, es decir,



va a depender del nivel de conocimientos técnicos que requieren del usuario (Alatorre
& Begueria, 2009).

Los modelos de erosion atienden las leyes fisicas y quimicas que controlan los
procesos erosivos (arranque y transporte de particulas de suelo y rocas labiles).
Actualmente existe un gran numero de modelos de erosion, en los cuales existen
diferencias como: complejidad, escala y resolucion espacial del andlisis, procesos que
consideran, representacion del medio fisico y cantidad y tipo de datos que se requieren

para su calibracion (Alatorre & Begueria, 2009).

2.9.1 METODOS CUANTITATIVOS
Permiten la estimacién numérica de la erosion, con el propésito de establecer
diferentes grados de la misma; estos modelos pueden emplearse para el desarrollo

de modelos cualitativos (Flores-Islas, 2016).
De evaluacion directa

Estos métodos permiten determinar la magnitud de la erosibn mediante mediciones
directas sobre el terreno, de pardmetros asociados al suelo, de los sedimentos
producidos y ademas de estimaciones a partir de ensayos. Algunos de los métodos

existentes y mas utilizados son:
e Agujas de erosién (Sancho et al., 1991)
e Estaciones de aforo y colectores (Gallart, 1992) citado en (Flores-Islas, 2016)
e Lotes de escurrimiento (Garcia & Lépez, 2009) citado en (Flores-Islas, 2016)

¢ Perfiladores microtopograficos (Sancho et al.,1991)
e Simuladores de lluvia (Bubenzer & Jones, 1971)

De evaluacion indirecta
Permiten la simulacién de escenarios y prediccion de los fendmenos fisicos a corto,
mediano y largo plazo. Este tipo de evaluacion consiste en el empleo de modelos para

representar la realidad (Flores-Islas, 2016).



Los modelos erosivos de manera general se dividen de tres maneras dadas en funcion
de los procesos fisicos simulados, los algoritmos del modelo que describen esos

procesos Yy la dependencia de los datos del modelo:
e Empiricos o estadisticos/métricos

Son generalmente los mas sencillos, basandose en el analisis estadistico de un

conjunto de observaciones (Alatorre & Begueria, 2009). EI modelo mas destacado es:
Ecuacién Universal de Pérdida de Suelo (Wischmeier & Smith, 1978)
e Conceptuales

Estan basados en la representacion del sistema que implica la erosion como una serie
interna de almacenamientos entre los que se establecen relaciones matematicas de

tipo simplificado.
e De base fisica

Se basan en los métodos de las leyes fisicas que controlan las estrechas relaciones
entre los diferentes parametros contenidos y los procesos observados.

La Tabla 1, muestra algunos modelos de evaluacién indirecta (empiricos,

conceptuales y de base fisica) segun Alatorre & Begueria (2009).



Tabla 1. Modelos de erosién y transporte de sedimentos.

Modelo Tipo Escal'a Escala ~ Base de Resultados Referencia (afio)
espacial temporal datos
USLE Empirico Ladera Anual Alta Erosion Wischmeier & Smith, 1978
ANSWERS Fisico Peq. Evento/ Alta Escorrentia, pico maximo, Beasley et al., 1980
Cuencas Continuo erosion, sedimentos,
produccion de sedimentos
HSPF Conceptual Cuenca  Continuo Alta Escorrentia, tasa de Johanson et al., 1980
escorrentia, carga de
sedimentos
CREAMS Fisico Parcela Evento/ Alta Erosién, depositacion Knisel, 1980; Knisel, 1995
Continuo
KINEROS/ Fisico Ladera/ Peq. Alta Escorrentia, pico maximo, Smith, 1981; Smith et al.,
KINEROS2 Cuenca Evento erosion, produccion de 1995a y 1995b; Woolhiser
sedimentos et al., 1990
EPIC Fisico Ladera/ Peq. Alta Erosion Williams et al., 1983
Cuenca  Continuo
MMF Empirico/ Ladera/ Peq. Anual Moderada Escorrentia, erosion Morgan et al., 1984;
Conceptual Cuenca Morgan, 2001
PESERA Fisico Ladera/  Continuo Alta Escorrentia, erosion, Kirkby et al., 2000
Regional sedimentos
AGNPS Conceptual Peq. Evento/ Alta Escorrentia, pico maximo, Young et al., 1989
Cuencas Continuo erosion, produccion de
sedimentos
IHACRES-WQ Empirico/ Cuenca  Continuo Baja Escorrentia, carga de Jakeman et al., 1990;
Conceptual sedimentos Jakeman & Hornberger,
1993
THORNES Conceptual/ Ladera/ Peg. Anual Moderada Escorrentia, erosion Thornes, 1990
Empirico Cuenca
TOPOG Fisico Ladera Continuo Alta Riesgo de erosion, CSIRO Land and Water,

escorrentia, pico maximo,

TOPOG Homepage



WEPP

RUSLE

PERFECT
SWAT

IQQM

EROSION 3D
LISEM
RUSLE-3D
USPED

SHETRAN

GUEST

MIKE-11

Fisico

Empirico
Fisico

Conceptual

Conceptual

2D-Fisico
Fisico
Empirico/
Conceptual
Empirico/

Conceptual
Fisico

Fisico

Fisico

Ladera/
Cuenca

Ladera

Parcela
Cuenca

Cuenca

Cuenca
Peq.
Cuencas
Cuenca

Cuenca

Cuenca

Parcela

Cuenca

Peg.
Continuo

Anual

Continuo
Continuo

Continuo

Evento
Evento
Anual

Evento/

Anual
Evento

Continuo

Continuo

Alta

Alta

Alta
Alta

Moderada

Alta

Alta

Moderada

Moderada

Alta

Alta

Alta

solutos, produccion de
sedimentos

Escorrentia, produccion
de sedimentos, pérdida de
suelo

Erosion

Escorrentia, erosion
Escorrentia, pico maximo,
erosion, produccion de
sedimentos

Escorrentia, sedimentos,
oxigeno disuelto,
demanda biolégica de
oxigeno

Escorrentia, erosion,
sedimentos

Escorrentia, sedimentos

Erosion
Erosién, depositacion

Escorrentia, pico maximo,
sedimentos, produccion
de sedimentos
Escorrentia,
concentracion de
sedimentos

Produccion de
sedimentos, escorrentia

Nearing et al., 1989; Laflen
etal., 1991

Renard et al., 1991y 1994

Littieboy et al., 1992
Arnold et al., 1995

DLWC, 1995

von Werner, 2000; Schmidt
et al., 1997

de Roo et al., 1996; de Roo
& Jatten, 1999

Mitasova et al., 1996; Mitas
& Mitasova, 1998

Mitasova et al., 1996; Mitas
& Mitasova, 1998

Wicks & Bathurst, 1996

Rose et al., 1997

Hanley et al., 1998



EUROSEM

SPL

LASCAM
WATEM

SEDNET

EMSS

STREAM
CASC2D-SED

SEAGIS

AGWA

Fisico

Empirico/
Conceptual
Conceptual
Conceptual

Conceptual/
Empirico

Conceptual

Conceptual
Fisico

Empirico/
Conceptual
Conceptual/

Fisico

Peq.
Cuencas
Cuenca

Cuenca
Cuenca

Cuenca

Cuenca
Cuenca
Peq.
Cuencas

Cuenca

Cuenca

Evento

Anual

Continuo
Anual

Anual/
Continuo
Continuo

Evento

Evento/
Continuo

Anual

Continuo

Alta
Moderada

Alta
Moderada

Alta

Baja

Moderada
Alta

Alta

Alta

Escorrentia, erosion,
sedimentos

Erosion fluvial, incision en
rios

Escorrentia, sedimentos
Erosion

Sedimentos en
suspension, contribucion
del flujo superficial,
procesos de rills y gullies
Escorrentia, carga de
sedimentos

Escorrentia y erosion
Escorrentia, pico maximo,
erosion y sedimentacién
separando las particulas
por tamafnos

Erosién, produccion de
sedimentos

Escorrentia, pico maximo,
erosion, produccion de
sedimentos

Morgan et al., 1998

Stock & Montgomery, 1999
Viney y Sivapalan, 1999
Van Oost et al., 2000; Van

Rompaey et al., 2001
Wilkinson et al., 2004

Vertessey et al., 2001

Cerdan et al., 2002
Rojas, 2002

DHI, 2003

Burns et al., 2004




2.9.2 METODOS CUALITATIVOS

Este tipo de metodologias estan basadas en la observacion de la erosion con apoyo
de material cartogréfico de percepcion remota y observacion en campo (Flores-Islas,
2016).

e Teledeteccion

Consiste en un conjunto de técnicas de observacion de la superficie terrestre a partir
de sensores aerotransportados o instalados en satélites capaces de ofrecer
informacion en diferentes longitudes de onda (visible, infrarrojo, térmico, microondas,
etc.) y comunmente se obtienen datos de: cobertura de suelo, relieve, suelos, rocas y

biomasa (Alatorre & Begueria, 2009).
e Sistemas de Informacion Geogréfica (SIG)

Un SIG es un sistema de tipo informatico disefiado para almacenar, analizar y
procesar informacion referenciada geograficamente mediante una proyeccion y su
sistema de coordenadas contenido, y relacionarla con bases de datos no espaciales.
En la aplicacién de modelos de erosiéon en un SIG puede resultar de ayuda como
herramienta auxiliar para el analisis espacial de datos cuantitativos (elevacion,
hidrometeorologia) y tematicos (litologia, tipo de suelo, cobertura) (Alatorre &
Begueria, 2009).

Segun ESRI (s.f.), creador del software ArcGIS, éste es definido como “Un completo
sistema que permite recopilar, organizar, administrar, analizar, compartir y distribuir
informacion geografica”. Mismo que se utiliza por personas de todo el mundo, con la
finalidad de poner el conocimiento geografico de manera accesible para cualquier
usuario y al servicio de los diferentes sectores (gubernamental, empresario, de
ciencia, de educacién y los medios). Ademas de ser un sistema que puede estar
disponible en cualquier lugar a través de navegadores Web, dispositivos moviles

(smartphones) y equipos de escritorio.

De manera general, las personas utilizan ArcGIS porque les permite realizar diferentes

tareas enfocadas a (ESRI, s.f.):



e Resolver problemas

e Tomar mejores decisiones

¢ Planificar adecuadamente

e Ultilizar los recursos mas eficientemente

¢ Anticipar y administrar los cambios

e Administrar y ejecutar las operaciones de forma mas eficaz

e Promocionar la colaboracion entre equipos, disciplinas e instituciones
e Aumentar la comprension y los conocimientos

e Comunicar de forma mas efectiva

e Educar y motivar a otros

2.10 MODELO DE LA ECUACION UNIVERSAL DE PERDIDA DE SUELO REVISADA
La Ecuacion Universal de Pérdida de Suelo Revisada de Renard et al. (1997) es una
version actualizada de la ecuacion original desarrollada por (Wischmeier & Smith,

1978). Expresada bajo la ecuacién siguiente:

A=R*K*LS*C*P
Donde:
A = Pérdida de suelo potencial media anual (Mg ha! afio?)
R = Factor de erosién por precipitacion y escorrentia (MJ mm ha* h' afio?)
K = Factor de erodabilidad del suelo (Mg ha h ha'* MJ't mm-1)
LS = Factor de longitud y de gradiente de la pendiente (adimensional)
C = Factor de cobertura vegetal (adimensional)
P = Factor de practica de conservacion/soporte (adimensional)

A la Ecuacién Universal de Pérdida de Suelo de Wischmeier & Smith (1978), Renard
et al. (1991) le realizaron algunas modificaciones, las cuales muestran las siguientes

caracteristicas:



e Computarizaciéon de algoritmos para facilitar los calculos.
¢ Nuevos valores de erosividad de lluvias y escurrimientos en condiciones aridas.
e Desarrollo de una variable estacional en términos de erodabilidad del suelo (K).

¢ Un enfoque de subfactores para calcular el término de manejo de cobertura (C),
donde los subfactores representan consideraciones de uso previo de la tierra,
dosel de cultivo, cobertura de superficie y rugosidad de la superficie.

e Nuevos algoritmos de longitud y pendiente de talud (LS) que reflejan las

relaciones de erosidn en surcos e intersurcos.
e Capacidad de calcular los productos LS para pendientes de diferentes formas.

¢ Nuevos valores de practicas de conservacion (P) para pastizales, rotaciones

de cultivos en franjas, valores de factores de contorno y drenaje subterraneo.
Algunos cambios con respecto a los parametros son:
e Estimacion del factor K en funcion del didametro de particulas.

¢ Modificacibn a la erosionabilidad del suelo segun las variaciones
estacionales, ademas de una metodologia alterna cuando el nomograma no

es aplicable.

e EIl parametro LS refleja las relaciones de erosion en surcos, asi como la

forma de la pendiente.

¢ Modificaciones al factor C para poder ser estimado segun su uso de tierra,

copa del cultivo, cobertura superficial y rugosidad del suelo.

2.11 Los SIG EN EL ASPECTO AMBIENTAL

Ante los desafios que hay que enfrentar en el futuro para la conservacion de los
recursos naturales, los Sistemas de Informacion Geogréafica se convierten en esa
herramienta de relevancia para el analisis, disefio modelizacion e implementacion de
planes de manejo encaminados a conservar dichos recursos del ambiente. Por su

caracter multidisciplinar de estas aplicaciones se permite elaborar modelos que no



solo representen situaciones actuales, sino también de aquellas posibles a suceder
en un futuro, permitiendo asi enriquecer su mejor gestion y toma de importantes

decisiones determinantes para una conservacion (Ramirez et al., 2017).

El desafio principal al que se enfrenta el sector agropecuario reside de manera
importante en compatibilizar la produccion con la conservacion del ambiente y los
recursos naturales, debido a que la sociedad pone su confianza en los productores
agropecuarios de doble manera: el uso de la tierra y la proteccion de los bienes y
servicios que de esta se desprenden. Y para lograr mantener estas grandes
responsabilidades serda necesario instrumentar politicas de indole publico que
permitan a los productores ser los protagonistas de ese cambio y la sociedad que los
rodea, contribuir en la premiacion a aquellos que mantengan las practicas en el tiempo

a corto y largo plazo (Ramirez et al., 2017).

Estudios como el realizado por Kushwaha & Yousuf (2017) indican que las tecnologias
de teledeteccion se desarrollan bajo un papel importante en el ambito del mapeo para
la evaluacién del riesgo a la erosion del suelo en la agricultura, los bosques y tierras
degradadas. Su aplicacién induce nuevas oportunidades que permiten la planificacion
y gestion de la conservaciéon, aumentando su capacidad si se combina con modelos
empiricos de prediccion de la erosién como la RUSLE. Los modelos de prediccion de
erosion integrados a teledeteccion y SIG no solo estiman la pérdida de suelo, sino que

también proporcionan las distribuciones espaciales de la erosion.

2.12 OBRAS Y PRACTICAS DE CONSERVACION DE SUELOS

Para la conservacion y restauracién de suelos es necesaria la ejecucion de obras o
practicas para controlar los procesos de degradacion en sus diferentes niveles,
rehabilitar los suelos, asi como mantener la productividad potencial, estas obras y

practicas se implementan a corto, mediano y largo plazo (CONAFOR, 2018a).

La CONAFOR (2018a), recomienda una serie de consideraciones para seleccionar

las obras o practicas mas acordes a las necesidades de terreno degradado:



e Consultar informacién del area: Informacion bibliogréfica y cartografica de la
region para poder interpretar condiciones de suelo, vegetacion, clima, relieve,

etc.

e Verificacidbn en campo del predio: Recorrer el predio a trabajar, observar nivel
y tipo de degradacion, delimitar las zonas y pendientes, determinar algunas

propiedades del suelo y aspectos de cobertura.

e Seleccién de obras: Definir la propiedad principal de los trabajos (ladera o en

carcavas) y elegir la obra adecuada.

e Realizacibn de célculos: Para obras a aplicar en laderas se calcula

principalmente la distancia existente entre curvas a nivel.

e Capacitacion y ejecucion de obras: Capacitacion técnica para duefios y
poseedores, asi como a asesores técnicos, para la realizaciéon de obras y

practicas.

Existe un gran numero de obras y practicas para el control de la erosion laminar
0 en céarcavas, las primeras consisten en tratamientos mecanicos 0 manuales en

terrenos con laderas degradadas. Los objetivos y beneficios que estas presentan son:
e Retener suelo y sedimentos
e Disminuir el grado y longitud de la pendiente
e Impedir la formacion de carcavas
e Reducir el contenido de sedimentos en el agua de escorrentia
e Captar agua de lluvia, propiciando la infiltracion de agua
e Interceptar escurrimientos y disminuir su velocidad

e Incrementar el contenido de humedad en el suelo, lo que coadyuva al

establecimiento de la vegetacion de tipo forestal

e Mejorar la calidad del agua



Algunas obras que se realizan con materiales vegetales, ya sean vivos o muertos,
aportan una cantidad importante de materia organica al suelo, mejoran el paisaje y los
sistemas de produccion desarrollados en laderas (aprovechamientos productivos) y
se pueden generar productos adicionales como lefia y forraje.

Existen una gran variedad de obras y practicas para controlar la erosion laminar, que

a continuacion se enlistan:
e Zanja bordo
e Zanjatrinchera
e Terrazas de formacion sucesiva
e Terrazas individuales
e Bordos en curvas a nivel
e Roturacion
e Barreras de piedra acomodada en curvas a nivel
e Acomodo de material vegetal muerto
e Practicas vegetativas
e Terrazas de muro vivo
e Barreras vivas
e Cortinas rompevientos
e Enriquecimiento de acahuales
e Sistemas agroforestales con especies de cobertura
e Practicas alternativas para la mitigacion de la sequia
e Sistema Nigarim

e Bordos en “V”’



De igual manera existen obras para el control de la erosion en carcavas, quienes
representan la degradacion extrema de un terreno, modifican el relieve y lo vuelven
practicamente improductivo para cualquier uso. Los objetivos que persigue el control

de céarcavas son:
e Control de los escurrimientos superficiales
e Correccion de la pendiente del cauce
e Disminuir la produccion y arrastre de sedimentos
e Mejorar la calidad del agua escurrida
e Estabilizacion de taludes
e Propiciar el desarrollo de la vegetacion, principalmente natural
e Aumentar la infiltracion y recarga de acuiferos
e Captacion del agua
e Mejorar el acondicionamiento hidraulico de los causes (rios)

Los trabajos a nivel de carcava se realizan siempre y cuando las practicas a nivel
ladera no sean suficientes para controlar el escurrimiento. De acuerdo a los tipos de

crecimiento de una cércava, los trabajos para su control se dividen en:
Control de longitud

e Cabeceo de céarcavas con piedra

e Cabeceo de carcavas mediante zanjas interceptoras de escorrentia
Control de amplitud

e Estabilizacion de taludes
Control de profundidad

e Presas para el control de azolves

e Presa de malla de alambre electrosoldada



Presa de morillos

Presa de ramas

Presa de piedra acomodada
Presa de llantas

Presa de mamposteria
Presa de gaviones

Presa de geocostales



3. ANTECEDENTES

3.1 EVALUACION DE LA EROSION HIDRICA EN EL MUNDO

A nivel mundial se han realizado una gran cantidad de estudios de erosion a través

del modelo de la EUPS, ya sea en su forma original o en sus formas modificadas, que

ademas han tenido mejoras y propuestas para la evaluacion de cada uno de los

factores que la componen, por ello, se mencionan a continuacion algunos de los mas

actuales realizados a nivel mundial:

Chadli (2016) realizé un estudio enfocado a estimar la erosion hidrica en la
cuenca de Sebou (Marruecos), donde menciona que debido a que se requiere
gran cantidad de informacion para su célculo se utilizé un SIG (ArcGIS 10.2)
que le permitié ahorrar tiempo para optimizar y procesar la informacion. De este
modo pudo determinar que la erosion en el area esta influenciada por la
combinacion de cada uno de los factores que comprenden el modelo, arrojando
que el 78.83% del area de estudio presenta bajo riesgo a la erosiony el 17.36%

un riesgo medio.

Boakye et al. (2020) mencionan en su trabajo que la aplicacion de los modelos
RUSLE y SEDD a los SIG permiten estimar de manera facil, rentable y rapida
la distribucioén de la erosion del suelo en la cuenca del rio Pra, asi como el
rendimiento de los sedimentos fluviales, tomando en cuenta cada uno de los
factores que integran los modelos. Esto mostré que la erosion del suelo varia
de acuerdo con los tipos de usos de la tierra, sefialando que el 21.3% de la
cuenca presenta erosion que va de severa a muy severa. Concluyendo que sus
resultados obtenidos permitiran servir como base para la planificacion y gestion

de los recursos naturales para garantizar el desarrollo sostenible de la cuenca.

Martinez-Murillo et al. (2020) realizaron la validacién del factor K a través del
modelo de la RUSLE aplicado a paisajes ecogeomorfologicos mediterraneos
contrastados (sur de Espafia) mencionando que la degradacion del suelo es
mas dinamica en aquellas zonas donde la geomorfologia y uso del suelo es

mas promovente, por ello existen diferentes maneras de determinar la erosion.



La dindmica del suelo es influenciada por el uso del suelo que a su vez es
incrementada por la cobertura vegetal. EI parametro del factor K puede ser

mejorado analizando facciones de los agregados.

Barrena-Gonzalez et al. (2020) realizaron un estudio en la segunda regién mas
productora de vinos en Espafia encontrada en la parte suroeste del pais, en el
cual no se han hecho ningun estudio de erosion. Por ello se aplicaron los
modelos del ISUM y la RUSLE para evaluar la erosion a largo plazo siendo
evaluadas parcelas experimentales en un vifiedo de 20 afios bajo el sistema de
labranza y otro bajo suelo desnudo. Para estos 2 métodos se encontraron
diferencias significativas de al menos 5 veces, teniendo en cuenta que las
mayores pérdidas se dieron en las partes altas siguiendo la direccion de la
ladera. Concluyendo que debido a las grandes diferencias entre modelos es
importante realizar evaluaciones en otros vifiedos para determinar la idoneidad

de la evaluacion.

Behera et al. (2020) utilizaron el modelo de la RUSLE integrado a SIG para la
cuantificacion del potencial de erosion del suelo en escenarios futuros de
cambio climatico, mencionado que las actividades realizadas por el hombre
tienen gran impacto en la pérdida de suelo, por ello es importante evaluar la
erosion actual y bajo condiciones futuras con la finalidad de permitir realizar
actividades que garanticen su permanencia. Si se presentan mapas a mayor
detalle (resoluciones pequefias) se tendra una mayor certeza del grado de

afectacion generada por aquellos factores que incluye la RUSLE.

Bai & Cui (2021) hacen hincapié en su investigacion que la pérdida de suelo y
la escorrentia en areas de cultivo actualmente tienen la atencion en todo el
mundo, por ello la propuesta de una mejora a la RUSLE (un modelo que no
puede predecir la pérdida de suelo en aquellos afios donde la distribucion de la
lluvia es significativamente atipica a la ley de distribucién anual) puede lograr

un resultado de simulacion mas efectivo en la prediccion de la pérdida de suelo.



3.2 EVALUACION DE LA EROSION HIDRICA EN MEXICO

En México existen varios trabajos relacionados con la aplicacion de la EUPS en su

forma original o revisada, combinadas con SIG para la evaluacion de la erosion hidrica

bajo diferentes condiciones, de entre los que destacan los siguientes:

SEMARNAT-CP (2003) indican que en el proyecto denominado “Evaluacién de
la Degradacion de los Suelos Causada por el Hombre en la Republica
Mexicana, escala 1:250,000”, se realiz6 una valoracion directa en campo bajo
la metodologia de Evaluacién de la Degradacion del Suelos causada por el
Hombre (conocida como ASSOD) en la cual se establece el tipo de degradacién
actual de los suelos, sus niveles de afectacion, extensiones (superficie) que
ocupan, tasas actuales que presentan y las causas que la originan, utilizando
como mapa base la delimitacion de sistemas terrestres, sobre los
espaciomapas del INEGI. Bajo esta evaluacion se encontré que para el estado
de Hidalgo el 44.39% de su territorio presenta algun tipo de proceso de
degradacion los cuales se representaron de la siguiente manera: erosion edlica
(5.42%), erosion hidrica (5.94%), degradacion fisica (3.95%) y degradacién
quimica (29.08%).

Loredo-Osti et al. (2007) en su trabajo denominado “Prediccion de riesgo a la
erosion hidrica a nivel microcuenca” evaluaron la erosién hidrica a través de la
EUPS y los SIG en una microcuenca (Portezuelo) de San Luis Potosi, donde
se determinaron cada uno de los factores asociados a la formula y una vez
obtenidos los resultados se procedieron a evaluar los niveles de erosién que se
presentaron, bajo esos valores obtenidos se dieron una serie de
recomendaciones de manejo con la finalidad de determinar las acciones

necesarias para mantener el recurso suelo.

Montes-Leo6n et al. (2011) realizaron una investigacion donde plasmaron un
Mapa Nacional de Erosion Potencial, el cual fue construido utilizando la
informacion mas reciente disponible en el que pudieran evaluar los factores de
la USLE que implica la erosién potencial, lo cual les permitiera identificar

aguellas zonas del pais mas susceptibles a sufrir erosion, y de esta manera



implementar planes de manejo u algun otro tipo de medidas que mitiguen su

efecto en los sitios donde la pérdida de suelo sea alta o extrema.

Sanchez—Hernandez et al. (2013) mencionan que su investigacion tuvo como
objetivo generar mapas teméticos de los factores que provocan la erosién en
la cuenca Grijalva-Usumacinta, mediante la aplicacion de le EUPS y la
interpolacién de los datos en un SIG en el cual se establecieron tres niveles de
erosion (alto, medio y bajo) obteniendo como resultado que mas del 50% de la
cuenca tiene geoformas onduladas y escarpadas, suelos predominantemente
someros, los cuales son facilmente erosionables cuando se asocian a
precipitaciones intensas. El mapa generado de erosion potencial de la cuenca
indicé que mas de 7 millones de hectareas (83%) presentan riesgo de erosion

de medio a alto, acentuandose en la parte Centro y Suroeste.

Vargas-Lomelin (2015) en su tesis de licenciatura estimo la erosion actual y
potencial de la subcuenca de Sayula en el estado de Jalisco. Los valores de
erosion actual que encontré fueron de un rango de 0 a 46.21 Mg ha?! afiol y
los correspondientes a erosion potencial estuvieron entre las 9.17 a 96.47 Mg
ha'l afio! con distribuciones variadas dentro del area. Bajo los resultados
obtenidos menciona que algunas areas requieren accién inmediata para la
realizacion de obras y practicas de conservacion de suelos, y debido a que la
mejor manera de evitar la degradacion de los suelos por erosion hidrica es la
conservacion de la cobertura vegetal, recomienda el acompafiamiento con
reforestaciones de planta nativa y propia del tipo de vegetacién de la zona,
ademas de un analisis de la erosion edlica para tener una idea mas clara de la

degradacion de los suelos.

Gonzalez-Morales et al. (2018) bajo el modelo de la RUSLE, estimaron la tasa
de erosion promedio en seis comunidades rurales en la Sierra Madre del Sur,
Chiapas, donde sus resultados arrojaron tasas que van de las 28 a 717 Mg ha
Lafioly de acuerdo a esto mencionan que los valores tan altos estan asociados
a una alta erosividad pluvial y pendientes pronunciadas, ademas de que

muchas de las tasas mas altas de erosion se encuentran en comunidades que



estan dominadas por bosques pero de donde se ha eliminado la mayor parte
de la cubierta arborea. Y segun datos de una encuesta CAP aplicada, mas de
la mitad de los encuestados cree que la reforestacion es una opcion viable para
reducir la erosion del suelo, aunque también indicaron que los esfuerzos

gubernamentales de reforestacion se han visto obstaculizados.

Lépez-Garcia et al. (2020) estimaron la erosion del suelo utilizando la EUPS y
SIG en la localidad de Tzicatlacoyan, Puebla, donde sus resultados arrojaron
que la localidad enfrenta riesgo de erosién del suelo con una tasa promedio
anual de 117.18 Mg ha' afio!, debido a factores naturales y actividades
antropogénicas. Los resultados ademas indicaron que el 13.33% del territorio
de Tzicatlacoyan presentan valores de pérdida de suelo superiores a los
tolerables y de acuerdo a lo analizados mencionan que el modelo EUPS vy los
SIG podrian permitir a los usuarios de la tierra tomar mejores decisiones sobre
el uso y conservacion del suelo y ecosistema, agregando criterios cientificos a

sus conocimientos tradicionales.



4. JUSTIFICACION
Hasta el momento no existen trabajos especificos en el estado de Hidalgo, incluyendo
Santiago Tulantepec, que cuantifiquen la pérdida de suelo potencial y actual causada
por erosion hidrica, de esta manera, en la presente investigacion se efectuara un
estudio en el &rea para calcular la cantidad de suelo que se pierde anualmente a causa
de las lluvias, considerando cada uno de los factores integrantes de la EUPSR.
Ademas, con los valores obtenidos para la superficie que comprende el municipio de
Santiago Tulantepec, se propondran una serie de obras y précticas de conservacion
y restauracion de suelo con la finalidad de controlar las pérdidas de suelo, y asi evitar

su degradacién a corto, mediano y largo plazo.



5. OBJETIVOS

5.1 OBJETIVO GENERAL

El objetivo general de este trabajo es determinar el riesgo potencial y actual a la
erosion hidrica del suelo en el municipio de Santiago Tulantepec, Hgo., a través de la
EUPSR integrada a los SIG para identificar las zonas de mayor riesgo a la pérdida de

suelo.

5.2 OBJETIVOS ESPECIFICOS
e Determinar cada uno de los factores que comprenden el modelo de la EUPSR

con ayuda de los SIG.

e Estimar la pérdida de suelo por efecto de la erosiéon hidrica en Santiago

Tulantepec.

e Generar la cartografia de erosion hidrica potencial y actual de Santiago

Tulantepec.

e Proponer obras y practicas de conservacion y restauracion de suelos basadas

en los niveles de erosién hidrica actual en el area de estudio.



6. PLANTEAMIENTO DEL PROBLEMA

La pérdida de suelo por erosion es generalizada y reduce ampliamente la
productividad de los ecosistemas naturales, agricolas, forestales y de pastos, y al
mismo tiempo con el crecimiento de la poblacion humana, la erosion del suelo, la baja
disponibilidad del agua, un cambio climatico por consumo de combustibles fosiles y la
pérdida de biodiversidad, se convierten en los principales problemas ambientales en

todo el mundo (Pimentel & Burgess, 2013).

Segun un estudio publicado por la FAO (2008) la degradacién del suelo esta
aumentando con severidad y extension en muchas partes del mundo, con mas del
20% de las tierras agricolas afectadas, 30% de los bosques y el 10% de los pastizales.
La importancia de tomar a consideracion estos datos, se debe a que cerca de 1,500
millones de personas (un cuarto de la poblacion mundial) dependen directamente de

suelos sujetos a degradacion. (FAO, 2008)

Desafortunadamente, en México no existen los trabajos suficientes para la estimacion
de la erosion hidrica a corto y largo plazo y los existentes como el de la SEMARNAT-
CP (2003) pueden generalizar los datos de erosion a nivel nacional, ya que se pueden
presentar grandes subestimaciones o sobreestimaciones, a esto se le agrega el uso
de metodologias donde solo se toman en cuenta algunas propiedades de los suelos
ocasionando que se dejen fuera otras propiedades que también influyen en el
fendmeno de erosidén. Ademas, la informacion actualizada es muy limitada, por lo que
la consideracion de trabajos muy antiguos hace mas dificil la correcta gestién del

territorio y el aseguramiento de la productividad del suelo.



7. HIPOTESIS

Los factores que componen la EUPSR pueden integrarse adecuadamente al software
ArcGIS 10.8 para su determinacion correcta y eficiente, de igual manera este permite
la generacion de mapas de distribucion de la erosion, obteniendo como resultado que
un alto porcentaje de la superficie del municipio de Santiago Tulantepec se encuentra
bajo el régimen de riesgo medio y alto por erosiéon hidrica y con base en las
estimaciones obtenidas permitird hacer las propuestas de obras y practicas de

conservacion y restauracion de suelos.



8. MATERIALES Y METODOS

8.1 CARACTERIZACION DEL AREA DE ESTUDIO
Para la caracterizacion de este estudio, se tom6 como referencia el poligono que

comprende el municipio de Santiago Tulantepec (Figura 1).
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Figura 1. Poligono de Santiago Tulantepec.
Elaboracion propia a partir del INEGI (2021a).

8.1.1 LOCALIZACION

El municipio de Santiago Tulantepec de Lugo Guerrero se localiza en la porcion
suroriental del estado de Hidalgo, entre los paralelos 19° 59" y 20° 05" de latitud norte
y entre los meridianos 98° 20"y 98° 29 de longitud oeste (INEGI, 2009), cubriendo una
superficie total de 64.25 km?, lo que representa solo el 0.31 % de la superficie total del
estado de Hidalgo (INEGI, 2021a). Colinda al norte con el municipio de Tulancingo de

Bravo, al este con el municipio de Cuautepec de Hinojosa, al sur con los municipios



de Cuautepec de Hinojosa y Singuilucan y al oeste con los municipios de Singuilucan
y Tulancingo de Bravo (INEGI, 2009).

8.1.2 FISIOGRAFIA

La superficie que cubre el municipio de Santiago Tulantepec de Lugo Guerrero se
localiza en su totalidad dentro de la Provincia Fisiografica Eje Neovolcanico. En esta
region existen un sistema de lomerio (90%) combinado con una zona de valle (10%)
(INEGI, 2009).

8.1.3 HIDROGRAFIA
Santiago Tulantepec se ubica dentro de la region hidrolégica RH 26 rio Panuco,
subregion hidrologica alto Panuco del rio Moctezuma y la cuenca alta del rio Metztitlan.

Presenta una corriente principal, representada por el rio San Lorenzo (INEGI, 2009).

8.1.4 CLIMA

Con base en la clasificaciéon climatica de W. Koéppen, adaptada a las condiciones de
la Republica Mexicana por E. Garcia, se determina que un poco mas del 99% del
territorio del municipio presenta un clima de tipo templado subhimedo con lluvias en
verano y poco menos del 1% es de tipo semiarido templado con lluvias en verano
(Garcia & CONABIO, 1998). Ademas, presenta un rango de temperatura que va de
los 12 a los 16 °C y precipitaciones que van de los 500 a los 900 mm (INEGI, 2009).

8.1.5 USO DE SUELO Y VEGETACION

De acuerdo con los datos del Conjunto de Datos Vectoriales de Uso de Suelo y
Vegetacion, escala 1:250,000, Serie VII del (INEGI, 2021b), en la Tabla 2 se muestran
los tipos de uso de suelo y vegetacion presentes en Santiago Tulantepec, asi como
su mapa de distribuciéon dentro del municipio (Figura 2), de los cuales se puede

destacar con mayor proporcion zonas destinadas a uso agricola (71.27%).



Tabla 2. Uso de suelo y vegetacién de Santiago Tulantepec.

Uso de suelo y vegetacion Superficie (ha) %
Agricultura 4,578.62 71.27
Bosque 758.86 11.81
Pastizal 21.89 0.34
Urbano 760.60 11.84
Vegetacion secundaria 304.64 4.74
Total 6,424.61 100

Elaboracion propia a partir del INEGI (2021b).
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Figura 2. Mapa de uso de suelo y vegetacion de Santiago Tpec.
Elaboracion propia a partir del INEGI (2021b).

8.1.6 EDAFOLOGIA
De acuerdo con informacién del Conjunto de datos vectoriales edafolégico, escala
1.250,000, Serie Il (Continuo Nacional) del INEGI (2014), en la Tabla 3 se enlistan las
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unidades de suelo que se encuentran en Santiago Tulantepec y distribuidas segun lo

gue se puede observar en la Figura 3:

Tabla 3. Unidades de suelo de Santiago Tulantepec.

Unidad de suelo Superficie (ha) %
Cambisol 764.48 11.90
Feozem 570.34 8.88
Litosol 113.46 1.77
Luvisol 4,132.93 64.33
Vertisol 843.41 13.13

Total 6,424.61 100

Elaboracion propia a partir del INEGI (2014).
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Figura 3. Distribucién de las unidades de suelo en Santiago Tulantepec.
Elaboracion propia a partir del INEGI (2014).
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8.2 METODOLOGIA PARA EL CALCULO DE LA EROSION HIiDRICA ACTUAL

Para el célculo de la erosion hidrica actual de Santiago Tulantepec, fue necesaria la
aplicacion de la estructura del modelo de la Ecuacion Universal de Pérdida de Suelo
Revisada (EUPSR/RUSLE) de Renard et al. (1997). La forma bésica para el célculo

de la EUPSR se define de la siguiente manera:

A=R*K*LS*C*P

Donde:

A = Pérdida de suelo media anual (Mg ha! afio™?)

R = Factor de erosividad de la lluvia-escorrentia (MJ mm hat h'l afio?)
K = Factor de erodabilidad del suelo (Mg ha h ha'* MJ't mm-1)

LS = Factor de longitud y de grado de la pendiente (adimensional)

C = Factor de cobertura vegetal (adimensional)

P = Factor de practicas de conservacién/manejo (adimensional)

Para poder determinar el valor de la erosion hidrica actual se describen a continuacion
a detalle cada uno de los factores que integran el modelo de la EUPSR,
proporcionando detalles sobre la informacion necesaria de entrada, asi como las
ecuaciones necesarias para obtener cada valor. Todos los datos requeridos para
determinar el valor de los factores y las tasas de erosién actual del suelo se
procesaron a través de sistemas de informacidn geografica (para este estudio se
utilizé el software ArcGIS en su versiéon 10.8 (ESRI, 2019)) con la finalidad de obtener
de manera factible la distribucidon espacial de la erosion hidrica de Santiago
Tulantepec.

La delimitacion del poligono referencial que corresponde al municipio de Santiago
Tulantepec se genero a partir del area comprendida por el mismo municipio segun

datos del INEGI (2021a), el cual fue procesado en el software ArcGIS 10.8.



8.2.1 FACTOR DE EROSIVIDAD DE LA LLUVIA-ESCORRENTIA (FACTOR R)

El factor R (factor de tipo climatico) representa para un area especifica, la energia
potencial que tiene la lluvia, asi como su escurrimiento asociado para causar erosion
(Montes-Ledn et al., 2011).

Desafortunadamente, para México y otras partes del mundo la informacion
meteoroldgica sobre la intensidad de las lluvias se encuentra limitada, por ello se han
desarrollado modelos empiricos alternativos para estimar los valores del factor R en

funcién de otros parametros de la lluvia (Santacruz-De Leo6n, 2011).

Existen variados métodos para estimar el factor R, entre ellos se encuentra la
metodologia propuesta por Cortés en 1991, la cual ha sido trabajada por autores
como: Loredo-Osti et al. (2007), Montes-Leo6n et al. (2011) y Ordéiez-Rodriguez
(2017). Cortés, a partir de modelos de regresion cre6 14 regiones (Tabla 4)
estadisticamente homogéneas para toda la Republica Mexicana (Figura 4),
permitiéndole asi calcular el factor R de un area estudiada (Loredo-Osti et al., 2007).

Tabla 4. Ecuaciones regionales para la Republica Mexicana (Cortés, 1991).

Region Ecuacion R2
I 1.20785*P + 0.002276*P? 0.92
[l 3.45552*P + 0.006470*P? 0.93
11 3.67516*P — 0.001720*P? 0.94
v 2.89594*P + 0.002983*P2 0.92
\Y 3.48801*P — 0.000188*P?2 0.94
VI 6.68471*P + 0.001680*P? 0.90

VI (-0.03338)*P + 0.006661*P? 0.98
VIII 1.99671*P + 0.003270*P? 0.98
IX 7.04579*P — 0.002096*P?2 0.97
X 6.89375*P + 0.000442*P2 0.95
Xl 3.77448*P + 0.004540*P2 0.98
Xl 2.46190*P + 0.006067*P2 0.96
X 10.74273*P — 0.001008*P2 0.97
XV 1.500046*P + 0.002640*P2 0.95

Elaboracion propia. Fuente: Loredo-Osti et al. (2007).



Figura 4. Regiones de México para el factor R (Cortés, 1991) en Montes-Leédn et al. (2011).

El factor R para Santiago Tulantepec se determind aplicando la ecuacion
perteneciente a la Region | de la metodologia de Cortés (1991), esto se logré saber
utilizando el mapa asociado a la misma, con la finalidad de lograr identificar la region
de erosividad a la cual pertenece el area de estudio:

Region I:

R =1.20785 * P + 0.002276 * P?

Donde:

R= Factor de erosividad de la lluvia en MJ mm ha! h* afio!
P= Normal de precipitacion media anual en mm

Posteriormente, se obtuvieron los datos pluviograficos de las estaciones

meteoroldgicas (Tabla 5) ofrecidas por el Servicio Meteoroldgico Nacional, las cuales



contienen registros de precipitacion de por lo menos 30 afos (periodo 1951 — 2010),
ademas se consideraron aquellas que presentaban un area de influencia sobre la

distribucion de la precipitacién dentro y fuera del poligono de estudio (Figura 5).

Tabla 5. Precipitacion media anual registrada en las estaciones meteoroldgicas con influencia en
Santiago Tulantepec para el periodo 1951 — 2010.

Estacion Localizacion X Y Altitud Ppt
1 Santiago Tpec 566058 2216524 2179 588
2 La Esperanza 569597 2217829 2218 554.1
3 El Aserradero 570543 2206520 2610 755.2
4 Singuilucan 550948 2207651 2650 587.7
5 El Zembo 546328 2229187 2310 856.2

Elaboracion propia a partir de la CONAGUA (s.f).
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Figura 5. Mapa de localizacion de las estaciones meteoroldgicas con influencia de precipitacion en
Santiago Tpec.



Una vez obtenidos los datos de las estaciones meteoroldgicas y segun lo realizado
por Pastrana-Ortiz, 2014, fue necesario realizar la interpolacion bajo el método de

interpolacion Kriging a través del modulo Geostatistical Analyst de ArcGIS 10.8.

A continuacion, mediante la ecuacion asociada y el uso de la funcién Map Algebra de
ArcGIS, se procedié a generar un mapa tipo raster del factor R. Finalmente, mediante
la herramienta Reclassify del software, se procedi6 a clasificar la erosividad de la lluvia
de acuerdo a los valores recomendados por Rivera & Gomez (1991) (Tabla 6) citados

por Castelan-Vega et al. (2014).

El procedimiento que se siguio se describe en el apartado “Anexo 1”.

Tabla 6. Clasificaciéon de la erosividad de la lluvia para el valor de R segln Rivera & Gomez (1991).
Erosividad R

Clase Clasificacion
(MJ mm ha-! h-! afio-1)
1 < 1,000 Natural
2 1,000 a 2,500 Muy baja
3 2,500 a 5,000 Baja
4 5,000 a 7,500 Moderada
5 7,500 a 10,000 Alta
6 10,000 a 15,000 Muy alta
7 15,000 a 20,000 Severa
8 > 20,000 Extremadamente severa

Elaboracion propia a partir de Castelan-Vega et al. (2014).

8.2.2 FACTOR DE ERODABILIDAD DEL SUELO (FACTOR K)

El factor K indica el grado de susceptibilidad o resistencia de un horizonte especifico
del suelo a la erosion. La erodabilidad representa un valor promedio integral anual de
la pérdida de suelo en respuesta a procesos de erosion e hidrolégicos (Montes-Ledn
et al., 2011).

Para el estudio de este factor se utilizé la metodologia de la FAO (1980) citada en
Salazar-Arrieta (2016), por lo que fue necesaria la informacién referente a los suelos,

siendo asi la misma que lleva por nombre Conjunto de datos vectoriales edafologicos,



escala 1:250,000, Serie Il (Continuo Nacional) del INEGI (2014), de donde se obtuvo

la informacién referente a las unidades y/o subunidades de suelo y su textura.

Con la finalidad de actualizar la textura presente a lo largo del area de estudio, se
realizO un muestreo de suelos en cuadrantes de 1,000 m que permitieron obtener
muestras representativas que incluyeran todos los tipos de uso de suelo y vegetacion
y sus diferentes inclinaciones a través del municipio. Las muestras de suelo tuvieron
un peso de aproximadamente 150 g, las cuales fueron extraidas con ayuda de una
barrena hueca, para posteriormente procesarlas a través del método de Bouyoucos
(1962). Ya calculados los valores para cada cuadrante, se procedié a determinar su
valor integrado en cada unidad y subunidad de suelo presentes en el municipio,
teniendo en cuenta que més de la mitad de la superficie del cuadrante debi6 estar
integrada para poder ser considerado y de este modo promediar los valores
calculados anteriormente. Una vez obtenidos los promedios para los tipos de suelo,
se clasificé la textura superficial en: gruesa, media o fina, de acuerdo a las
recomendaciones de Castellanos-Ramos (2000) (Tabla 7), lo cual permitié determinar

el valor del factor K segun los valores asignados por la FAO (1980) (Tabla 8).

Tabla 7. Caracteristicas de clasificacion de textura (Castellanos-Ramos, 2000).

Textura Contenido
Gruesa > 50% arena y < 20% arcilla
Media < 35-40% arcillay < 50% arena
Fina > 40% arcillay > 60% limo

Elaboracion propia a partir de Castellanos-Ramos (2000).

Tabla 8. Valores del factor K en funcién de su unidad y subunidad de suelo y su clase textural
superficial (FAO,1980).

Unidades y subunidades de suelo de acuerdo a la Textura
clasificacion de la FAO
Simbolo Nombre Gruesa Media Fina
A Acrisol 0.026 0.040 0.013
Af Acrisol férrico 0.013 0.020 0.007

Ag Acrisol gléyico 0.026 0.030 0.013
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Rendzina

Ferrasol (acrico, humico, plintico, 6crico)
Gleysol

Gleysol (calcéarico, humico, malico)
Gleysol (districo, éutrico)

Gleysol (plintico, gélico, vértico)

Feozem (calcarico, gléyico, haplico, lavico)
Litosol

Fluvisol

Fluvisol calcéarico

Fluvisol (districo, éutrico)

Fluvisol (tiénico, plintico)

Kastafiosem (humico, célcico, lavico)
Luvisol

Luvisol albico

Luvisol cromico

Luvisol férrico

Luvisol (gléyico, calcico, ortico)

Luvisol (plintico, vértico)

Greysem (&crico, gléyico)

0.013
0.026
0.053
0.026
0.026
0.013
0.026
0.013
0.053
0.013
0.053
0.013
0.013
0.026
0.013
0.026
0.053
0.013
0.013
0.026
0.013
0.026
0.053
0.026
0.026
0.053
0.026
0.013
0.026
0.053
0.026

0.020
0.040
0.079
0.040
0.040
0.020
0.040
0.020
0.079
0.020
0.079
0.020
0.020
0.040
0.020
0.040
0.079
0.020
0.020
0.040
0.020
0.040
0.079
0.040
0.040
0.079
0.040
0.020
0.040
0.079
0.040

0.007
0.013
0.026
0.013
0.013
0.007
0.013
0.007
0.026
0.007
0.026
0.007
0.007
0.013
0.007
0.013
0.026
0.007
0.007
0.013
0.007
0.013
0.026
0.013
0.013
0.026
0.013
0.007
0.013
0.026
0.013



N (d,e,h)
O (d,e,x)
P

P (f.9)
Ph

P (0.p)
Q (a,ctb
R

Re

Rc

Rd

RXx

S

Sg

Sm

So

T

T (h,m)
T (0,v)

U

V (c.p)
w

W (d,e)
W (h,m)
Wx

X (k,h,1,9)
Y
(h,k,l,g,t)
Z

Z9

Zm

Nitosol (districo, éutrico, humico)
Histosol (districo, éutrico, gélico)

Podzol

Podzol (férrico,gléyico)

Podzol humico

Podzol (6rtico, placico)

Arenosol (albico, cAmbico, ferralico, lGvico)
Regosol

Regosol éutrico

Regosol calcarico

Regosol districo

Regosol gélico

Solonetz

Solonetz gléyico

Solonetz mélico

Solonetz ortico

Andosol

Andosol (huimico, mdlico)

Andosol (6crico, vitrico)

Ranker

Vertisol (crémico, pélico)

Planosol

Planosol (districo, éutrico)

Planosol (humico, mélico)

Planosol gélico

Xerosol (calcico, haplico, lavico, gypsico)
Yermosol (haplico, calcico, lavico, gipsico,
takirico)

Solonchak

Solonchak gléyico

Solonchak mélico

0.013
0.013
0.053
0.053
0.026
0.053
0.013
0.026
0.026
0.013
0.026
0.053
0.053
0.053
0.026
0.053
0.026
0.013
0.026
0.013
0.053
0.053
0.053
0.026
0.053
0.053

0.053
0.053
0.026
0.013

0.020
0.020
0.079
0.079
0.040
0.079
0.020
0.040
0.040
0.020
0.040
0.079
0.079
0.079
0.040
0.079
0.040
0.020
0.040
0.020
0.079
0.079
0.079
0.040
0.079
0.079

0.079
0.040
0.040
0.020

0.007
0.007
0.026
0.026
0.013
0.026
0.007
0.013
0.013
0.007
0.013
0.026
0.026
0.026
0.013
0.026
0.013
0.007
0.013
0.007
0.026
0.026
0.079
0.013
0.026
0.026

0.026
0.013
0.013
0.007



Zo Solonchak 6rtico 0.026 0.040 0.013
Zt Solonchak takirico 0.053 0.079 0.026

Elaboracion propia a partir de Loredo-Osti et al. (2007).

Finalmente, obtenidos los valores de cada unidad de suelo con base en su clase
textural, se procedié a crear el raster correspondiente al factor K con ayuda del

software ArcGIS.
En el apartado “Anexo 2” se indica el procedimiento aplicado.

8.2.3 FACTOR DE LONGITUD Y GRADO DE LA PENDIENTE (FACTOR LS)

Segun Foster et al. (1977) citado en Melchor-Marroquin & Chagoya-Fuentes (2016,
pag. 28) “la longitud (L) se define como la distancia horizontal entre los puntos donde
inicia el escurrimiento hasta aquel donde decrece la pendiente y ocurre la

sedimentacion. El factor (S) representa el efecto de la inclinacion en la erosion”.

Para determinar el factor LS fue necesario contar con el mapa topografico de
elevaciones tipo raster, conocido como “Conjunto de Elevaciones Mexicano 3.0” (CEM
3.0) con un tamafio de pixeles de 15 x 15 m, en su versién més actual y sin errores de
elevacion, el cual se obtuvo a partir de datos del INEGI (2012). Para el célculo del
factor L y de acuerdo a las recomendaciones de Chadli (2016), de manera inicial fue
necesario aplicar un relleno (conocido como Fill en ArcGIS) al modelo digital de
elevacion con la finalidad de evitar los posibles espacios vacios en el mismo,
posteriormente al raster resultante y corregido se le determiné la direccién de flujo
(herramienta Flow direction en ArcGIS) y al raster originado se le calculé la
acumulacion de flujo (herramienta Flow accumulation en ArcGIS). Consecutivamente,
se procedi6 a determinar el factor L, S y LS aplicando la metodologia de Renard et al.
(1997), bajo las diferentes adaptaciones para su correcto procesamiento en ArcGIS.
(INEGI, 2012):

Factor L: Longitud de la pendiente

sin©
A

m B 0.0896
1= () =i - o
22.13 'B (3+sin0)0-8+0.56




Donde:

A = Longitud de la pendiente (m)

m = Exponente de la longitud de la pendiente (Foster et al., 1977)
B = Pendiente a nivel de pixel (McCool et al., 1989)

8 = Angulo de la pendiente en radianes (multiplicar por 0.01745)

Con la finalidad de una correcta integracion a través de los SIG y bajo la metodologia
de Desmet & Govers (1996), Velasquez (2008) propuso la siguiente férmula y la cual

fue aplicada para el calculo del factor L:

+1
L Aap £ D™~ Ay
@) X™ x DMF2 % (22.13)™

Donde:

Aij = Area aportadora unitaria a nivel de pixel
D = Tamafio del lado del pixel

m = Exponente de la longitud de la pendiente

XM = Factor de correccion de forma (en sistemas pixelados es igual a 1)

Factor S: Grado de la pendiente:

Mediante la ecuacién de (McCool et al., 1987) se determiné el valor del factor:

S _ {10.8 sin B(i,j)+0-03 tanﬁ(i_]-) <0.09 }
@@©J) — | 16.8sin B(i_]-)—o.s tanﬁ(i_]-) =0.09

Donde:

Bij = Pendiente en grados (multiplicar por 0.01745)



Velasquez (2008) en Castro-Quintero et al. (2017) mencion6 que cuando se aplican
las formulas antes mencionadas en la funcion Raster calculator del software ArcGIS,
se debe considerar que el angulo de la pendiente debera ser expresado en radianes
dentro de éste, por lo que se debe aplicar su equivalencia matemética 1 grado
sexagesimal = 0.01745 radianes, con la finalidad de que los valores de L y S puedan

ser multiplicados por los componentes restantes de la EUPSR.

Finalmente, obtenidos los valores de L y S se aplicé la féormula de dicho factor de
acuerdo a las recomendaciones de Renard et al. (1997) para asi obtener el resultado

final de la distribucion de LS:
LS=Lx*S
Donde:
L = Factor de longitud de la pendiente
S = Factor de grado de la pendiente
El procedimiento que se siguid se describe en el apartado “Anexo 3”.

8.2.4 FACTOR DE COBERTURA VEGETAL (FACTOR C)

El factor C hace referencia a la capacidad que tiene la vegetacién para amortiguar el
efecto del desprendimiento de particulas de suelo por las gotas de lluvia e impedir el
arrastre de sedimentos a causa del escurrimiento superficial (Melchor-Marroquin &
Chagoya-Fuentes, 2016). El valor que toma C es la unidad, a medida que la cobertura
vegetal sea mayor, el valor que toma C es cada vez menor, es decir, O para terrenos
totalmente protegidos y 1 para terrenos sin ninguna proteccion (Montes-Leén et al.,
2011).

Para el célculo de este factor fue necesario el mapa de Uso de suelo y vegetacion
serie VII del INEGI (2021b), al cual se le realizdé una actualizacion de distribucion y
superficies a través del uso de imagenes satelitales Sentinel-2 del afio 2021,
procesadas en el software ArcGIS. Una vez obtenidos los datos de cobertura y uso de
suelo, se determinaron los valores asociados al valor de C con base a informacion

generada por diversas bibliografias (Figueroa et al., 1991; Becerra, 1999; Renard et



al., 1997; Montes-Leon et al., 2011; Pastrana-Ortiz, 2014; Flores-Islas, 2016; Ordofiez-
Rodriguez, 2017; Cordero-Rebolledo, 2022), y con la mayor similitud a las condiciones
actuales resultantes. De igual manera y debido a que el estudio del factor C en el area
evaluada es nula, se adapto a los sistemas y condiciones similares de la vegetacion

existente.

Las nuevas &reas y valores asignados se procesaron en el software ArcGIS para
obtener el mapa raster del factor C, segun su clasificacion, distribucion y los datos

correspondientes al uso de suelo y vegetacion.
En el apartado de “Anexo 4” se podra verificar el procedimiento aplicado.

8.2.5 FACTOR DE PRACTICAS DE CONSERVACION/MANEJO (FACTOR P)

Este Gltimo factor que integra la EUPSR representa la relacion existente entre la
pérdida de suelo y una practica de apoyo especifica en la que la erosion se ve afectada
al modificar el patrén de flujo o al reducir la cantidad y tasa de escorrentia. El valor
toma rangos que van de 0 a 1, donde 1 representa la inexistencia de una practica de
apoyo (Peri, 2017).

Algunas practicas de soporte que se consideraron en la evaluacion del factor P para
areas cultivadas son: surcado al contorno (comprende laboreo, siembra y plantacion
siguiendo las curvas de contorno o nivel), cultivos en faja, terraceo y establecimiento
de obras de drenaje subsuperficial. Ademas, para la asignacién de valores se tomo

como referencia lo expuesto por Wischmeier & Smith (1978) (Tabla 9).

Tabla 9. Valores del factor P para las diferentes préacticas.

Pendiente (%) Surcado al contorno Franjas al contorno Terraceo

laZ2 0.40* 0.20* 0.08*
3a8 0.50 0.25 0.10
9al2 0.60 0.30 0.12
13a16 0.70 0.35 0.14
17a 20 0.80 0.40 0.16
21a25 0.90 0.45 0.18

*Los valores fueron modificados, al considerar un error de expresion.



Para obtener los valores asociados al factor, fue necesario contar con informacion
acerca de las obras o practicas de conservacion de suelo aplicadas en el area de
estudio, y de manera enfocada solo a zonas de cultivo (segun las areas actualizadas
en el factor C), debido a que no se obtuvo informacién referente a obras aplicadas en
otras areas. Una vez obtenida la informacion, se procedié a asignar el valor
correspondiente, para posteriormente generar el mapa de distribucion del factor P a
través del software ArcGIS. Cabe mencionar, que en las superficies donde no existid

obra o practica alguna, se tomo el valor de practicas igual a 1.
En el apartado “Anexo 5” se desarrollan los pasos seguidos para el calculo del factor.

8.2.6 CALCULO FINAL DE LA EROSION HIDRICA ACTUAL

Con la obtencién de la informacién en mapas tipo raster de cada factor que comprende
la EUPSR, se multiplicaron los valores mediante la funcién Map algebra del software
ArcGIS, de acuerdo a lo recomendado por Vargas-Lomelin (2015), aplicando la
formula asociada a la erosion hidrica actual segun Renard et al. (1997) y finalmente
se procedié a la clasificacion de las areas en funcion de las clases de erosion
propuestas por la FAO (1979) (Tabla 10).

Tabla 10. Clases de riesgo a la erosion hidrica actual segin la FAO.

Riesgo Erosion hidrica actual (Mg ha? afio™)
Bajo <10
Moderado 10-50
Alto 50 — 200
Muy alto > 200

Elaboracion propia a partir de Chadli (2016).
El “Anexo 6” contiene los detalles del proceso aplicado.

8.3 METODOLOGIA PARA EL CALCULO DE LA EROSION HIDRICA POTENCIAL

Para el célculo de la erosion hidrica potencial de Santiago Tulantepec fue necesaria
la aplicacion de la estructura del modelo de la EUPS, al utilizar inicamente los factores
R, K, Ly S segun Wischmeier y Smith (1978), expresada como:

A=R*K*L*S



Donde:

A = Pérdida de suelo potencial media anual (Mg ha* afio™!)

R = Factor de erosividad de la lluvia-escorrentia (MJ mm hat h'! afio?)
K = Factor de erodabilidad del suelo (Mg ha h ha't MJ'1 mm?)

L = Factor de longitud de la pendiente (adimensional)

S = Factor de grado de la pendiente (adimensional)

De esta manera, una vez calculados los valores conforme a lo establecido para cada
uno de los factores de la EUPSR, se utilizo solo la informacién de los factores que
implican la erosion hidrica potencial (R, Ky LS) para posteriormente generar el mapa
de distribucion acorde a lo mencionado en el apartado del calculo de la erosion hidrica

potencial.

Y finalmente, se procedié a categorizar la erosion hidrica potencial de acuerdo a los
rangos propuestos para este trabajo (Tabla 11), debido a que no existe una
clasificacion especifica para las caracteristicas de suelo que se presentan en México
se tomaron las siguientes consideraciones que llevaron a determinar las categorias

de clasificacion para la erosion hidrica potencial:

1. Segun lo mencionado por Porta-Casanellas et al. (2003), la tasa de formacién
del suelo varia para los distintos ambientes y conocerla puede resultar de
interés, con la finalidad de determinar los niveles maximos de pérdida de suelo
por erosion, sin que el recurso desaparezca progresivamente. Teniendo en
cuenta que, en casi todos los casos, la tasa de formacion en afios supera
notablemente el numero de afios de vida del hombre, considerandose asi,
COMO un recurso no renovable a corto plazo.

De acuerdo con los autores, la tasa de formacién para aquella formacion
considerada como “Muy rapida (sobre cenizas volcanicas y clima humedo)” y
“Muy lenta (sobre calizas duras y clima templado-frio)” toma un aproximado de

<100 y <5,000 afios/cm respectivamente.



2. La SEMARNAT (2016), indica que 3 de los 6 grupos de suelo dominantes que
en conjunto representan el 51.7% de la superficie de suelos en México han
aumentado su uso destinado a la agricultura a pesar de sus caracteristicas
desfavorables para la misma. Ante ello, hace referencia a que los Leptosoles
presentan severas limitaciones para permitir enraizar a las plantas, debido a su
poca profundidad, los Regosoles son suelos considerados jovenes, por lo que
tienen poco o nulo desarrollo del perfil, mientras que los Calcisoles contienen
altos niveles de concentracion de carbonato de calcio.

3. De acuerdo con los datos obtenidos a partir del Inventario Nacional Forestal y
de Suelos 2015-2020 y los rangos de profundidades del suelo de la CONAFOR,
la profundidad promedio del suelo para selvas oscila de los 24.4 a 27.2 cm
(suelos considerados como someros), para los bosques de 21.6 a 45.1 cm
(suelos someros y medianos), mientras que en las zonas aridas va de 18.3 —
21.5 cm (suelos someros) y los manglares presentan un valor de 63.4 cm
(suelos profundos) (CONAFOR, 2018b; CONAFOR, 2020).

4. Se puede considerar que 1 mm de espesor de suelo es equivalente a 10 Mg
ha! de suelo (CONAFOR, 2012). Siempre y cuando la densidad aparente para
el suelo presente de referencia tenga un valor igual a 1.

5. La erosion del suelo en tierras agricolas actualmente es estimada de 10 a 20
veces (sin labranza) a mas de 100 veces (labranza convencional), superior a la
tasa de formacion del suelo (IPCC, 2019).

Tabla 11. Categorias de clasificacion de la erosion hidrica potencial

Pérdida de suelo (Mg ha? afio™) Riesgo
<2 Nulo
2-10 Bajo
10-25 Moderado
25-50 Severo
> 50 Extremo

Elaboracion y fuente propia.

Las categorias propuestas consideran las aseveraciones de los autores listados

anteriormente, las cuales permiten considerar una pérdida tolerable de suelo sin la



presencia de vegetacion u obras/practicas de conservacion de suelos, pero que a
corto plazo aseguran el mantenimiento de su productividad, aun posterior a su
eliminacion de aporte de nutrimentos (por aporte constante de materia organica) o la

ejecucion de obras/practicas de conservacion de suelos.

En el “Anexo 7” se describen los pasos seguidos para el calculo de la erosion hidrica

potencial.

8.4 METODOLOGIA PARA PROPONER OBRAS Y PRACTICAS DE CONSERVACION DE SUELOS

El poder contar con un mapa de erosion hidrica en el ambito local ayudara a identificar
las zonas donde es necesaria la implementacion de un plan de manejo en el cambio
de uso de suelo, asi como ubicar las zonas donde se requiera un estudio mas

detallado, entre otras (Montes-Leon et al., 2011).

De acuerdo con Kirkby & Morgan (1984) citados en Loredo-Osti et al. (2007) las

medidas de conservacion del suelo deben incluir cuatro acciones basicas:
1. Proteger el suelo contra el impacto de las gotas de lluvia.

2. Incrementar la capacidad de infiltracion con la finalidad de reducir el

escurrimiento superficial.

3. Mejorar la estabilidad de los agregados del suelo para hacerlo mas resistente

a la erosion por salpicamiento.

4. Aumentar la rugosidad de la superficie para reducir la velocidad del

escurrimiento.

Bajo estas medidas, las recomendaciones de manejo giraran en torno a las practicas
de manejo, conservacion y restauracion, dependiendo de la clase de suelo, su uso
actual y potencial y el riesgo a la erosion. También sera importante considerar cuales
son las practicas para el manejo eficiente del suelo de acuerdo a su capacidad de uso
y riesgo a la erosion (Loredo-Osti et al., 2007), tomando en cuenta las caracteristicas
y funciones de cada obra y practica presentadas en el Manual de obras y practicas de
la CONAFOR (2018a).



9. RESULTADOS Y DISCUSION

9.1 FACTORR

De acuerdo a los procesos aplicados y la formula asociada a la Regién | de la
metodologia de Cortés (1991), en Santiago Tulantepec los valores relacionados al
factor de erosividad de la lluvia toman un rango que oscila entre los 1,422.24 y los
1,804.52 MJ mm ha! h'! afio? (Figura 6), el cual y de acuerdo con la clasificacién de
Rivera & Gomez (1991) en Castelan-Vega et al. (2014) se encuentra en el rango de

“erosividad muy baja”.

Esta erosividad present6 una tendencia ascendente comenzando por la parte noreste
del municipio, en aquellos lugares donde los datos de las estaciones meteorologicas
indicaron valores de precipitacibn menor (La Esperanza y Santiago Tpec.),
dirigiéndose hacia dos zonas principales, donde se tienen los registros de lluvia mas
altos, una de ellas en la posicién oeste con valores de R mayores a las antes
mencionadas (Singuilucan y El Zembo), y la otra con valores ain mas altos en la parte

sureste, colindante con la estacién meteorologica de El Aserradero.

Los valores obtenidos y la tendencia de erosividad de las lluvias es comparable con
los resultados de otras investigaciones realizadas bajo la metodologia de Cortés
(1991) y con las condiciones de clima y/o precipitaciones similares. Para dar pauta a
estas, se puede hacer referencia a autores como: Flores-Lopez et al. (2003), quienes
encontraron un valor de 4,475 MJ mm ha ht afio? en la regién VIl y precipitacion de
822.1 mm; Prado-Hernandez et al. (2017) calcularon dentro de la microcuenca El
Malacate en la regién V un valor de R de 2,163.2 MJ mm ha h'! afio? en 769.6 mm
de precipitacion; mientras que Lopez-Garcia et al. (2020) en la region Il para la Mixteca
Poblana encontraron valores de 1,065 a 1,348 MJ mm ha! h* afio.

Es notable que la distribucion de la erosividad en el area de estudio esta
estrechamente relacionada con la topografia del terreno y la vegetacion existente, es
decir, las partes bajas con distribucion de pastizales, asentamientos humanos y areas
agricolas presentan menor susceptibilidad a la erosividad, comparadas con las partes
altas de un bosque templado de pino y/o encino, donde la vegetacion permite la

reduccion de los efectos erosivos de las precipitaciones, que segun los datos



encontrados, estas se distribuyen en mayor cantidad en las areas boscosas o

cercanas a las mismas.
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Figura 6. Mapa de distribucion del factor R en Santiago Tulantepec.




9.2 FACTORK

Segun la metodologia de la FAO aplicada para este factor, la clase textural resultante
durante su actualizacién, las unidades/subunidades de suelo presentes en el area
muestreada y lo representado en su mapa de distribucion (Figura 7), los valores de K
van de los 0.013 a 0.079 Mg ha h ha! MJ! mm, esto debido a que, segln los
promedios obtenidos para los sitios considerados dentro de cada unidad/subunidad
determinantes de la textura para los suelos, arrojaron que, 6 de las 7 subunidades
presentaron textura media con sus valores mas altos y solo la unidad Litosol presento
textura gruesa y con el valor mas cercano a 0 (0.013 Mg ha h hat MJ** mm™ el cual

solo representa el 1.77% de la superficie total.

Existen una gran variedad de trabajos que utilizan la metodologia de la FAO y al no
tenerse la informacion detallada, como alternativa para obtener datos mas cercanos a
la realidad, una gran variedad de autores tales como: Santacruz-De Ledén (2011);
Montes-Leon et al. (2011); Pastrana-Ortiz (2014); Pedraza-Villafafia (2015); Melchor-
Marroquin & Chagoya-Fuentes (2016); Flores-Islas (2016); Lépez-Garcia et al. (2020),
tomaron como referencia la metodologia antes mencionada, ya que de manera
original, la de mayor aplicacion es la realizada por Wischmeier & Smith (1978), donde
tomaron en cuenta propiedades como: contenido de materia organica, contenido de

arenas, limos, estructura, permeabilidad, etc.

De acuerdo con los valores de K obtenidos segun su unidad de suelo y clase textural,
se puede decir que aquellos suelos de tipo luvisol y por su uso de suelo actual
(agricola) presentan mayor susceptibilidad a la erosion, ya que de acuerdo con
Zamudio & Méndez (2011) los suelos agricolas tienden a degradarse a causa de las
precipitaciones y que ademas si estos se presentan compartiendo pastizal inducido.
Aunque de manera general y comparado con lo encontrado por Lopez-Garcia et al.
(2020) en su trabajo, la erodabilidad del suelo sugiere altos niveles de erosion.
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Figura 7. Mapa de distribucion del Factor K para el municipio de Santiago Tpec.
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9.3 FACTORLS

De acuerdo a los procesos aplicados al Continuo de Elevaciones Mexicano 3.0 con
una resolucion de 15 m por pixel, se pudo determinar la altitud que presenta el
municipio de Santiago Tulantepec, la cual indica que esta se encuentra dentro del
rango de los 2,152 a 2,731 m y de acuerdo a su mapa de distribucion (Figura 8) se
puede denotar que la parte norte, centro y sureste del municipio presenta los valores
mas bajos, la cual colinda en su mayor proporcion con el municipio de Tulancingo de
Bravo, de igual manera se observa que la altitud aumenta conforme se dirige hacia la
parte oeste colindante con el municipio de Singuilucan, presentando sus valores
maximos en la zona sur (también colindante con Singuilucan y ademas, con

Cuautepec de Hinojosa).
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Como se observa en el mapa de distribucion de las pendientes del terreno (Figura 9)
gue se localizan en el municipio, estas toman valores en un rango de 0 a 79%, las
cuales en su mayor porcentaje se concentran en la zona sur del municipio y donde se
encuentran las areas con mayor altitud. De acuerdo con la Tabla 12 y la clasificacion
de Ramalho-Filho & Beek (1995), en el area de estudio, las pendientes se concentran
entre el 0 y 8% (terreno plano y suavemente ondulado), lo que representa el 71.19%
de la superficie total, esto a través de todas las direcciones, aunque se destaca de
igual manera, la presencia de pendientes fuertes en la parte sur-sureste del municipio,
gue ademas revelan aquellas areas de mayor susceptibilidad a la erosion debido al

alto nivel de inclinacién del terreno.
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Figura 9. Mapa distribucién de pendientes en porcentaje del municipio de Santiago Tpec.
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Tabla 12. Tabla de porcentajes de area para cada rango de pendiente en Santiago Tpec.

Pendiente (%) Clasificacion Superficie (ha) %
0-3 Plano 2,605.36  40.55
3-8 Suavemente ondulado 1,968.63 30.64
8-13 Moderadamente ondulado 835.43 13
13-20 Ondulado 444.51 6.92
20 -45 Fuertemente ondulado 492.90 7.67
45 - 100 Montafioso 77.78 1.21

Total 6,424.61 100

Elaboracion propia a partir de Ramalho-Filho & Beek (1995).

Aplicada la metodologia de Renard et al. (1997) que describe el célculo del factor LS
y las adaptaciones realizadas para su aplicacion en el software ArcGIS, se encontro
gue el rango del factor esta dentro de los valores que van de 0 a 7, colocando a la
categoria de 0 a 2 como dominante, al concentrase en un 92% (Tabla 13) de la
superficie total y consecuentemente distribuido por todo el municipio (Figura 10).
Ademas, el mapa de distribucién expresa que los valores de LS mas altos se localizan
en aquellas areas donde se desarrollan las corrientes de agua, que de acuerdo con el
CEM 3.0 son las partes encontradas como depresiones dentro del terreno. Es de
importancia mencionar que los valores > 50 se localizan en puntos especificos de la
superficie, lo que nos indica que existen areas escarpadas, que ademas solo

representan el 0.02% de la superficie estudiada.



Tabla 13. Tabla de porcentajes de area respecto a rangos del valor de LS
para el municipio de Santiago Tpec.

Rango de LS  Superficie (ha) %
0-2 5,915.09 92.07
2-4 359.93 5.60
4 -7 115.63 1.80
7-10 12.37 0.19

10-50 20.41 0.32
> 50 1.17 0.02
Total 6,424.61 100

Elaboracion propia.
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Al comparar nuestros resultados con trabajos realizados bajo la misma metodologia o
metodologias similares como el de Montes-Leon et al. (2011,) en donde encontraron
para la RH12 de la Republica Mexicana valores de LS de 0.029-19.365, mencionando
que los valores mas altos estdn asociados para aquellas zonas con mayor pendiente
y los valores bajos se consideran como superficies planas. Mismo lo sucedido con el
trabajo de Lopez-Garcia et al. (2020) en una localidad de Puebla, México obteniendo
en sus calculos valores de 0.03 en areas planas y de 185 para regiones de montafia,
que ademas representan zonas de gran potencial a la erosién. Un caso de igual
metodologia, realizado por Gomes et al. (2017) en el Cerrado Brasilefio, indicé que
alrededor del 93% del area total evaluada presenta valores de LS de 0-5 referidos
como de moderada vulnerabilidad, mientras que el 2.69% presenta valores superiores
a 10, catalogados como de alta vulnerabilidad a la erosion. Por ello, se puede
considerar que, en aquellas areas con mayor diferencia de elevacion en longitudes
cortas, gradientes de pendiente altos y terrenos abruptos (montafias y lomerios), se
presentd un mayor valor del factor LS, que consecuentemente expresa consigo una
mayor susceptibilidad a la erosién hidrica, debido principalmente a su alta facilidad de

escorrentia.



9.4 FACTORC

La actualizacién del mapa de uso de suelo y vegetacion para el municipio, permitié
observar y determinar los cambios para el uso de suelo (Figura 11), que, de manera
inicial, estan generalizados y agrupados bajo categorias diferentes a las reales dentro
del uso de suelo y vegetacion serie VIl del INEGI, de este modo, se pueden observar
grandes cambios segun lo expresado en la Tabla 14, de entre los que resaltan una
disminucién de la superficie ocupada por agricultura (45%), el aumento sustancial de
pastizales (9.61%) y una consideracion importante de suelo destinado para

caminos/carreteras (4.03%).

Tabla 14. Concentrado de usos de suelo y vegetacién en Santiago Tulantepec para 2021.

Uso de suelo y vegetacion 2021 Superficie (ha) %
Agricultura 2,890.87 45.00
Asentamientos humanos 1,031.34 16.05
Bosque 1,143.60 17.80
Caminos/Carretera 258.89 4.03
Cuerpos de agua 35.04 0.55
Pastizal 617.31 9.61
Suelo desnudo/degradado 69.44 1.08
Vegetacion secundaria 307.97 4.79
Otros usos 70.15 1.09

Total 6,424.61 100

Elaboracion propia.

Con base en los datos obtenidos para el factor y de acuerdo con las referencias
utilizadas para la asignacion de valores segun C y que mejor se adaptaron a las
condiciones actuales (Tabla 15), se puede mencionar que este toma valores que van
de 0.001 a 1, siendo los valores cercanos a 0 aquellos asignados a areas boscosas
(encontradas principalmente en la parte sur, asi como en direccion este, aunque estas
dltimas, de menor cobertura) que permiten una alta proteccion al suelo debido a su
cobertura vegetativa presente, asi como de las areas que de manera definitiva o casi

definitiva cubren el suelo (asentamientos humanos urbanos y carreteras con 0.005 y



0.001 respectivamente), que a su vez ocupan poco mas del 20% de la superficie
municipal. Aunque sin dejar de mencionar las superficies ocupadas por asentamientos
humanos de tipo rural con un valor asignado de 0.45, expresando un riesgo medio
segun la proteccion brindada al suelo (repartidos en las zonas sur, sureste y este,
cercanas a las areas boscosas de mayor pendiente) y para finalmente tener valores
de 1 en los usos de suelo ocupados por caminos de indole rural, derechos de via
(oleoductos), suelos desnudos y areas con degradacion aparente, que en conjunto
representan poco mas del 5% de la superficie total del municipio (Figuras 11y 12).
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Tabla 15. Valores asignados a la vegetacion existente para el factor C segln diferentes bibliografias.

Uso de suelo y vegetacion 2021 SUFZEZ;ICIe % Valor C
Agricultura de riego anual y semipermanente (Alfalfa) 217.69 3.39 0.01
Agricultura de riego anual y semipermanente (Maiz) 550.77 8.57 0.03
Agricultura de temporal anual (Avena) 52.97 0.82 0.27
Agricultura de temporal anual (Maiz) 2,069.44 32.21 0.25
Asentamientos humanos (Rural) 711.96 11.08 0.45
Asentamientos humanos (Urbano) 319.37 4.97 0.005
Bosque de encino (Cobertura buena) 457.72 7.12 0.001
Bosque de encino (Cobertura mala) 255.02 3.97 0.006
Bosque de encino (Cobertura regular) 18491 2.88 0.004
Bosque de encino-pino (Cobertura mala) 11.59 0.18 0.01
Bosque de galeria 70.43 1.10 0.1
Bosque de pino (Cobertura mala) 19.23 0.30 0.005
Bosque de pino (Cobertura regular) 86.57 1.35 0.004
Bosque de tascate (Cobertura buena) 36.79 0.57 0.010
Bosque de tascate (Cobertura regular) 21.32 0.33 0.03
Caminos rurales 240.48 3.74 1
Carreteras 1841 0.29 0.001
Corrientes de agua 22.32 0.35 0.08
Cortinas rompevientos 3.89 0.06 0.009
Cuerpos de agua 35.04 0.55 0.001
Oleoducto 27.26 0.42 1
Pastizal natural 607.90 9.46 0.13
Pastizal (Dentro de bosque de encino-pino) 9.41 0.15 0.08
Relleno sanitario regional 16.68 0.26 0.45
Suelo con erosion aparente 4568 0.71 1
Suelo desnudo 23.77 0.37 1
Vegetacion arbustiva de bosque de encino 1595 0.25 0.08
Vegetacion arbustiva de bosque de pino 3.54 0.06 0.08



Vegetacion arbustiva de bosque de tascate 136.18 2.12 0.08

Vegetacion arbustiva de matorral crasicaule 69.00 1.07 0.65

Vegetacion secundaria arbérea de bosque de tascate 83.30 1.30 0.03
Total 6,424.61 100

En este sentido, se resalta la distribucién de las &reas destinadas a la agricultura, las
cuales, junto con las zonas de pastizales van ganando terreno frente a los bosques y
Su vegetacion asociada, lo que indica un cambio de uso de suelo, acompafiado de la
extension de los asentamientos humanos, que de forma agrupada representan casi

tres cuartas partes de la superficie total del municipio.

Coincidiendo con lo mencionado por Lépez-Garcia et al. (2020), los valores de C
confirman que el area de estudio ha sido fuertemente impactada por las actividades
humanas (principalmente enfocadas a usos agricolas y asentamientos humanos), que
a su vez han ocasionado la degradacion de los bosques. Aunado a ello, segun lo
sefalado por Zamudio & Méndez (2011) la vulnerabilidad a la degradacién del suelo
segun el tipo de cultivo se presenta en: hortalizas, frijol, maiz, mango y sorgo y
comparado con lo obtenido en el estudio, las &reas agricolas estan destinadas
principalmente al cultivo de maiz, indicando de este modo, una alta fragilidad al agente

erosivo.

Finalmente, destacar la aplicaciébn y combinacion de los SIG y las imagenes
satelitales, permite generar una clasificacion supervisada y aplicada a un modelo
elegido, como lo trabajado por Ghosal & Das Bhattacharya, (2020) y Kishore et al.
(2019).
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9.5 FACTORP

El célculo de los valores para las obras/practicas de conservacion de suelo, solo
tomaron relevancia en las areas agricolas destinadas a la produccion de maiz, debido
a que en cualquiera de los otros usos no se encontraron obras que permitieran su
consideracion dentro del estudio, por ello y de acuerdo con los valores para el surcado
al contorno del terreno (practica principal para el cultivo de maiz) en combinacién con
la pendiente presente y segun lo expresado en la Tabla 16, se asigné un rango que
va de 0.40 a 0.90 para las &reas dedicadas a la agricultura (maiz), de entre las que
destaca el valor de P de 0.50 con el 31.67% del area de estudio y al resto de la
superficie se le asignoé un valor igual a la unidad con una ocupacion superficial total
del 59.22%.

Tabla 16. Valores del factor P para surcado al contorno y su superficie ocupada en el municipio.

Factor P Superficie (ha) %
0.40 182.88 2.85
0.50 2,034.91 31.67
0.60 289.71 4.51
0.70 70.97 1.10
0.80 7.72 0.12
0.90 34.02 0.53

1 3,804.40 59.22
Total 6,424.61 100

Elaboracion propia.

Como se puede observar en la Figura 13, de los valores que destacan en cuanto a su
superficie ocupada e iniciando con el de 0.50, su distribucion esta practicamente a
través de todo el municipio con una concentracion mayor en la parte central y en
direcciones este y oeste. Continuamente, para el caso del valor asignado a 1, del
mismo modo se presenta a traves de todo Santiago Tulantepec, en el que la ausencia

de obras/practicas lo indican.

Desafortunadamente, son pocos los trabajos en los que se trabaja el factor P, debido

a la ausencia de obras/practicas de conservacion que puedan ser consideradas para



su evaluacion, esto lleva a asumir que la aplicacion de alguna medida preventiva y/o
correctiva para la conservacion del suelo esta limitada en la mayor parte de las areas.
Sin embargo, en trabajos como el realizado por Barrena-Gonzélez et al. (2020) en
Espafia, se utilizé un valor de 0.92 para un area destinada a vifiedo, con pendiente
del 7.1%, una distancia entre surcos de 2.8 m y 1.5 m entre plantas adaptadas en
valor a las condiciones dadas. Mismo procedimiento el realizado por Mukano et al.
(2019), quienes utilizaron los valores propuestos por Wischmeier & Smith (1978) para
su aplicacion en la cuenca del rio Ishim, Kazajistan en un area con mayor presencia
agricola (38.01%) y que de igual forma contemplo el uso de valores para P de 0.50 a
1.

Ante la limitante en México, relacionada a la ejecucién de obras/practicas, Cordero-
Rebolledo (2022) menciona que cuando estas son correctamente utilizadas se

convierten en una opcién viable para mitigar los efectos causados por la erosion.
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9.6 EROSION HIDRICA ACTUAL

De acuerdo con la metodologia de Renard et al. (1997) para el célculo de la erosion
hidrica actual en el que se toman en cuenta cada uno de los factores desarrollados
anteriormente (R, K, LS, C y P), como se observa en la Tabla 17, la erosion toma
valores que van desde menos de 10 hasta mas de los 200 Mg ha afio. El riesgo
clasificado como bajo que incluye pérdidas de suelo menores a 10 Mg ha* afio?
representan la mayor expresion de la erosion en 83.11% de la superficie total, seguido
por un riesgo moderado que ocupa 902.52 ha (apenas un 14.05%) para continuar con
los riegos alto y muy alto y de menor presencia al representar el 2.66 y 0.18% de la

superficie respectivamente.

Ahora bien, segun lo expresado en el mapa de distribucion actual (Figura 14), el riesgo
“bajo” se distribuye por todo el poligono que comprende el sitio de estudio, caso
comparado con el de tipo “moderado”, el cual se encuentra principalmente en la zona
este y sureste, combinando suelos con erosién aparente, desnudos y areas de uso
agricola, valores de P de 0.50 a 1, pendientes de al menos 20% pero que en algunos
casos pueden alcanzar el 45% de inclinaciébn, ademas de ubicarse en areas con

precipitaciones mayores a las distribuidas en la parte baja del municipio.

Para valores de riesgo “alto” y “muy alto”, estos se localizan de manera puntual y
contigua al riesgo moderado, pero bajo condiciones de pendiente mayores, que en
combinacion con la vegetacion limitada le otorgan una mayor susceptibilidad a la

erosion.

Tabla 17. Clasificacién de la erosién hidrica actual segun los niveles de riesgo propuestos por la FAO
(1980) y su superficie ocupada dentro del municipio.

Erosion hidrica actual Superficie

Riesgo %
(Mg hat afio™) (ha)
Bajo <10 5,339.57 83.11
Moderado 10 -50 902.52 14.05
Alto 50 — 200 170.70 2.66
Muy alto > 200 11.82 0.18
Total 6,424.61 100

Elaboracion propia.



Los valores resultantes y comparados con los obtenidos en una localidad de Puebla
por Lopez-Garcia et al. (2020) bajo condiciones comparables, se concuerda que los
valores estan relacionados con la actividad humana (eliminacion de la cubierta
vegetal, combinada con la sensibilidad de las areas a la erosion-mayor pendiente). Lo
mismo sucedido en el trabajo de Gonzéalez-Morales et al. (2018), quienes atribuyen
los valores mas altos a aquellas que sufrieron reduccién en su cubierta vegetal,

cambiando con los altos indices de precipitacion y pendientes.
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9.7 PROPUESTA DE OBRAS Y PRACTICAS PARA EL AREA DE ESTUDIO

Los valores de erosion hidrica obtenidos en el estudio a pesar de parecer de poca
relevancia, requieren una atencion precisa que permita atenuar el proceso erosivo a
corto, mediano y largo plazo, lo cual seré posible a través de la planeacion y ejecucion

de obras/practicas de conservacion.

De este modo, las acciones benéficas ocurridas por la presencia de vegetacion para
el control de la erosién se deben a dos factores principales: el follaje, que funciona
como medio de amortiguamiento de las gotas de lluvia al reducir su velocidad de
impacto y, por otro lado, el sistema radicular, tallos herbaceos y sus residuos, que
impiden el arrastre de suelo en el terreno, ademéas de verse limitado por arrastre

superficial o viento (Becerra-Moreno, 1999).

Autores como Rashid et al. (2016) mediante su trabajo realizado, demuestran que la
ejecucion de acciones de terraceo en terrenos de indole agricola bajo condiciones de
un clima semiarido, se aumenta la disponibilidad de humedad en un 16%,
acompafado de la disminucion de produccion de sedimentos y la pérdida de
nutrientes, que ademas no solo se detiene sino aumenta en un 20% durante la

produccién de trigo.

Y el uso de sistemas agroforestales bajo la integracion de especies de cobertera
(arboles o arbustos) asociados a herbaceas, que permiten la mitigacion de la erosion,
pérdida de fertilidad y los escurrimientos superficiales, que ademas de proteger y
generar estabilidad ecoldgica, permiten obtener productos de autoconsumo
(CONAFOR, 2018a).

Ante lo mencionado con anterioridad y segun los valores arrojados para cada uno de
los céalculos realizados para la erosién hidrica actual, a continuacién, se enlistan las
propuestas de obras/practicas de conservacion de suelo y agua para Santiago

Tulantepec:



Riesgo bajo:

v

Para areas destinadas a la agricultura y con posibilidad de la integracion de
riego, se recomienda reconvertir las tierras a un uso pecuario, esto a traves del
establecimiento y manejo de forrajes de corte, lo que permite la presencia de
cobertura vegetal por un mayor tiempo

Zonas boscosas que no presentan riesgo alguno, deben de conservar su
cobertura vegetal, evitando de este modo la exposicion del suelo durante
posibles aprovechamientos, que lo hacen susceptible a su degradacion.

Las areas de agricultura de riego con aprovechamiento de alfalfa para forraje,
deben seguir conservando su forma de manejo, sin la necesidad de

sobreexplotar o cambiar su uso actual.

Riesgo medio

v

En areas de pastizal, donde existe una extensa cantidad de cabezas de
ganado, es necesario establecer programas de manejo de pastizales, a fin de
distribuir correctamente la carga animal, sin necesidad de sobreexplotar las
areas de aprovechamiento.

Se recomienda una revegetacion de causes naturales, cuando estos presentan
problemas de cobertura, y que mejor realizarlas mediante la integracion de
especies nativas de la zona de atencion.

La rotacion de cultivos combinado con la incorporacién de materia organica
permite la mejora de las condiciones de suelo, ademas trae consigo una mejora
en la productividad, que se traduce en el aumento de los ingresos econémicos
para el poseedor.

Cuando existen riesgos en parcelas dentro de pendientes no aptas para la
agricultura, es recomendable que se aplique agricultura de conservacion,
permitiendo asi, dejar sobre la superficie del terreno al menos un 20% de los
residuos de cosecha.

Disminuir el grado de fragmentacion de las tierras, se traduce en una
permanencia de mayor cantidad de vegetacion sin la necesidad de cambiar su

uso de suelo original.



Riesgo alto y muy alto:

v' El implemento de barreras vivas (de nopal, maguey, etc.), ademas de retener
los azolves, permiten la filtracién de agua, que a su vez ofrece materas primas
gue se pueden aprovechar con fines comerciales.

v' Se recomienda la integracién de pastizales y/o cualquier tipo de accion que
incluya la revegetacion de las zonas con pérdidas considerables.

v En zonas de agricultura, pastizal o boscosas, acciones como el establecimiento
de barreras de piedra acomodada en zonas de alta pendiente permiten no solo
la reduccion de la velocidad de los escurrimientos, sino también la retencion del
suelo.

v Acciones de cabeceo de carcavas o el establecimiento de presas de control de
azolve (geocostales, morillos, piedra acomodada, etc.), resultan ser la mejor
alternativa cuando la erosion se manifiesta en gran medida, que ademas resulta

ser dificil de controlar con obras/practicas menores.

De acuerdo con la CONAFOR (2018a), la asignacion y ejecucién de las
obras/practicas de conservacion para los diferentes usos de suelo y condiciones
topogréficas y climaticas no solo implican las bases tedricas, sino también deben de
estar respaldadas por evaluaciones en campo directo, con la finalidad de determinar

su tamario, forma y objetivo.

Cada una de las recomendaciones antes enlistadas no solo se pueden establecer por
si solas, sino también pueden ser combinadas unas con otras, a fin de garantizar la

permanencia y/o recuperacion del suelo.



9.8 EROSION HIDRICA POTENCIAL

Teniendo en cuenta la metodologia de Wischmeier & Smith (1978) para el calculo de
la erosion hidrica potencial, en la que para su estimacion solo se toman en cuenta los
factores R, Ky LS, se logro obtener el mapa de distribucion (Figura 11) de la misma.
La Tabla 18 muestra a la clase “nula” con una ocupacion de 391.16 ha de la superficie
total (6.09%), la cual se encuentra distribuida principalmente en la parte noreste del
municipio, expresando los menores indices de R y areas de topografia plana aunque
los mayores valores de K. Caso similar con la distribucién de la clase “baja”, la cual se
localiza en la zona norte con una ocupacion de 9.70% (623.27 ha), diferente a lo
expresado por las clases “moderada”, “severa” y “extrema”, que en conjunto ocupan
mas de ¥ partes de la superficie total (5,410.18 ha), distribuidas a través de todo el
municipio pero con concentraciones principales en la zona sur, suroeste e inclusive
este y en las zonas de mayor pendiente (mayor rango del factor LS) e indices de R
(mayores precipitaciones). También se denotan los valores de erosion hidrica
potencial superiores a 50 Mg ha' afio, se expresan en pequefias lineas curvas, las
cuales son indicadoras de la presencia de corrientes de agua, que ademas de acuerdo
al CEM, es donde convergen depresiones topograficas que dan origen a los

escurrimientos naturales.

De acuerdo con lo arrojado en este trabajo y datos comparables como los obtenidos
por Gaitan et al. (2017) en la Republica Argentina para erosion hidrica potencial,
demostraron que a nivel nacional la tasa de pérdida ronda las 166 Mg ha? afio?
(equivalente a 1.2 cm de suelo por afio), y de acuerdo a la clasificacion en su grado
“leve” (<10 Mg ha afio) casi un 40% de la superficie se presenta en zonas planas y
con precipitaciones medias a bajas, mientras que alrededor del 10% presenta tasas
de erosién potencial “muy altas” (> 200 Mg ha* afio™!) en zonas con fuertes pendientes
y altas precipitaciones. Esto concuerda con cada uno de los datos encontrados en la
distribucion de la erosion hidrica potencial para Santiago Tulantepec.

Aunque, diferente a lo realizado en 2007 por Loredo-Osti et al., donde obtuvieron para
una microcuenca de San Luis Potosi los cuatro rangos de erosion de la FAO, teniendo
los valores mas altos en la parte centro y norte de ésta, a pesar de ser una cuenca

catalogada con clima seco estepario templado y precipitacion media nula de 304.5



mm, se calcularon valores de R de 1,158.398 Mj mm ha! hrt, en suelos de tipo litosol

con textura media, pendientes que rondan de 8 a 20% y una mayor predominancia de

erosion hidrica potencial “ligera” y “moderada”.
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Figura 15. Mapa de distribucion de la erosion hidrica potencial en Santiago Tpec.

Tabla 18. Tabla de clases de erosion hidrica potencial dentro del municipio, expresada en superficie y

porcentaje ocupado.

Clases Erosién hidrica potencial  Superficie Area

(Mg hat afio™?) (ha) (%)

Nula <2 391.16 6.09

Baja 2al0 623.27 9.70
Moderada 10a 25 1370.92 21.34
Severa 25a50 1982.68 30.86
Extrema > 50 2056.59 32.01
Total 6424.61 100.00

82



10.CONCLUSION
El uso de los Sistemas de Informacion Geografica permite integrar y calcular de
manera eficiente cada uno de los factores que comprende la Ecuacion Universal de
Pérdida de Suelo, lo que conlleva a poder utilizar una gran cantidad de informacién
sin la necesidad de demandar otros aspectos que podrian retrasar los tiempos de
calculo y/o procesamiento, considerando que cada uno de los procesos deben ser
ejecutados correctamente y sin influir en ellos. Ademas, es posible la evaluacion de la
erosion hidrica actual y potencial de un &rea de trabajo relativamente grande como lo
es Santiago Tulantepec, comparada con parcelas de un tamafio pequefio, facil de

recorrer, analizar y evaluar.

La combinacién EUPSR-SIG, no solo ayuda al procesamiento de grandes cantidades
de datos en un solo medio, contrastado con las herramientas tradicionales de trabajo
utilizadas para cuantificar los fenomenos que le aquejan a la sociedad, sino también
permite la expresion a través de mapas interactivos de distribucién del fenédmeno
erosivo y cada uno de los factores que lo componen, que a su vez expresan de manera
mas sencilla los detalles y/o cambios sufridos para un area especifica de interés. Es
decir, permite la expresion global de datos que resultan ser el inicio de una infinidad
de posibles situaciones y aplicaciones las cuales son definidas con base en los
objetivos e intereses de cada usuario.

Consecuentemente, ademas de expresar la informacién de manera visual, genera el
acceso a los datos estadisticos de interés, como lo es la erosién hidrica actual y
potencial enunciada en Mg ha' afio! para el sitio de evaluacién, aunque los valores
obtenidos no son precisamente los sucedidos en la realidad, estos permiten generar
ciertas consideraciones y acciones para la toma de decisiones. En adicién a los datos,
su distribuciéon espacial y el panorama generado tras su analisis e interpretacion y con
el objetivo de dar certeza, es necesario la aplicacion y acompafamiento a traves de
algun método de estudio directo, que permita tener las bases con respecto a la erosion
hidrica que puede estar sucediendo realmente, asi como de esas variaciones

originadas a traves del tiempo.



11.CONSIDERACIONES Y RECOMENDACIONES
Lo expresado por los valores obtenidos no deben suponer que estos no representan
un riesgo alto, la decision final debe ser acompafada de datos obtenidos de la realidad

mas actual.

Por ello, es importante tomar en cuenta cada una de las consideraciones incluidas
para el estudio y de este modo, adelantarse a lo que posiblemente podria suceder si
no se toman en cuenta las propuestas emitidas. Mejorando asi, el uso y aplicacion de
cartografia e imagenes de escala limitada, ademas de los procesos y sus

calibraciones al momento de configurar la informacion a manejar.

De igual manera, se considera que, si existe un correcto estudio, seguido de un
analisis completo, se lograra realizar una planeacién eficiente que nos llevara a una
asertiva toma de decisiones para la conservacion de los suelos y el medio que directa
o indirectamente soporta. Aunque parezca un asunto de limitada importancia y de
poca valoracion, la conservacion de un recurso natural como lo es el suelo, debe ser
tomada en cuenta, llevando a cabo practicas sustentables para su cuidado, debido a
gue es la base fundamental en el desarrollo de nuestra economia y de la permanencia

en la calidad y productividad de las areas vitales para la humanidad.

Finalmente, no solo se trata de establecer acciones de mitigacion o recuperacion de
areas con problemas de erosién, sino también, del desarrollo y aplicacion de politicas
publicas en las que se vele por los intereses generales, permitiendo la inclusion de
cada uno de los sectores afectados sin beneficiar o afectar a ciertas areas, todas
encaminadas a garantizar un Unico objetivo, el desarrollo sustentable y sostenible de

la region y el pais.
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ANEXOS

Procedimiento seguido y aplicado en el
software ArcGIS 10.8 para el calculo de
la erosién hidrica actual del municipio de

Santiago Tulantepec.

Municipio a modelar

Para iniciar fue necesario contar con el
mapa de la divisiéon politica municipal del
afo 2021, el cual fue obtenido del Portal
de Geoinformacion de la CONABIO para
posteriormente seguir los pasos que a

continuacion de describen:

Una vez cargado el mapa, se dirigi6
mediante la ruta ArcToolBox > Analysis
Tools > Extract > Select y de esta

manera seleccionar la herramienta

correspondiente (Figura 16).

ArcToolbox O =

[ ArcToolbox
= @9 3D Analyst Tools
= & Analysis Tools
= & Extract
#, Clip
~ B
#, Split
3 Split By Attributes
#., Table Select
+ @y Overlay
+ & Proximity
+ &y Statistics
3 @ Cartography Toels
3 @ Conversion Tools
3 @ Data Interoperability Tools
7 B Data Management Tools
+ B9 Editing Tools
3 @ Geocoding Tools
3 @ Geostatistical Analyst Tools
- . - e

Figura 16. Localizacion de la herramienta Select.

Ya abierto el cuadro de datos (Figura 17),
se procedi6 a elegir la informacion
necesaria para cada apartado y asi
obtener el mapa del &rea a estudiar
(Figura 18).

<, Select - o x

Input Features

[mun2ogw = &
Output Feature Class

| €:\Capas Investigacién\1a_Proyecto\PoligonolsantiagaTpec shp =]

Expression (optional)
[ "NOM_MUN" = 'santiago Tulantepec de Lugo Guerrero' |

Environments... Show Help =

Figura 17. Configuracién de herramienta Select.

Figura 18. Poligono de Santiago Tulantepec

ANEXO 1

Factor R

Para la obtencion del Factor R
(erosividad de la lluvia) fue necesaria la
consulta de datos del Servicio
Meteorol6ogico Nacional, con la finalidad

de tabular la informacién de coordenadas



UTM, precipitaciones medias anuales del
periodo 1953 — 2010 y su altitud para
cada estacion meteoroldgica ubicada
dentro y fuera del &rea de estudio y con

influencia en la misma.

Una vez registrados los datos en una
tabla de Excel y en formato .txt, se
procedié a subir los puntos de referencia
de las estaciones meteorolégicas y
obtener el archivo

tipo  shapefile

correspondiente.

De este modo, sobre el archivo de las
estaciones meteorolégicas dentro de
ArcGIS, se siguio la ruta Click derecho >
Display XY Data (Figura 19) y asi
informacion

configurar segun la

necesaria (Figura 20).

B Open

Joins and Relates >
X Remove
Data >
Edit Features 3
Geocode Addresses..,
Display Route Events...
Display XY Data... ‘

@

=
%1

x

B

Properties...
T

Figura 19. Herramienta Display XY Data.

A table containing X and Y coordinate data can be added to the
map as a layer

Choose a table from the map or browse for another table:

| Estaciones Meteorologicas 1951-2010.txt J
Spedify the fields for the X, ¥ and Z coordinates:

X Field: |x ~ |
¥ Field: |v w |
Z Field: |A|ﬁb.|d ~ |
Coordinate System of Input Coordinates
Description:
Projected Coordinate System:
Name: WGS_1984_UTM_Zone_14N
Geographic Coordinate System:
Name: GCS_WGS_1984
[Jshow Details Edit...

Warn me if the resulting layer will have restricted functionality

About adding XY data oK Cancel

Figura 20. Configuracién de herramienta Display XY
Data.

Al archivo de puntos generado, se le dio
Click derecho > Data > Export Data y
se le asigné un nombre de salida para
finalmente obtener el shapefile de las

estaciones meteorolégicas (Figura 21).

Figura 21. Puntos localizacion de las estaciones
meteoroldgicas.

Una vez generados los puntos de

referencia para cada estacion

meteoroldgica, se procedid a aplicar el

método de interpolacion Kriging para



obtener la distribucion de las lluvias en el
area de estudio y el cual consistio en
seguir la ruta ArcToolBox > Spatyal
Analyst Tools > Interpolation > Kriging
(Figura 22).

ArcToolbox o x
& Editing Tools
&9 Geocoding Tools
&9 Geostatistical Analyst Tools
&3 Linear Referencing Tools
& Multidimension Tools
&3 Network Analyst Tools
G Parcel Fabric Tools
@ Schematics Tools
B Server Tools
9 Space Time Pattern Mining Tools
= &9 Spatial Analyst Tools
& Conditional
& Density
& Distance
&y Extraction
& Generalization
& Groundwater
& Hydrology
= B Interpolation

“, IDW
=

”% Matural Meighbor
#, Spline

Figura 22. Localizacion de la herramienta Kriging.

Al cuadro de configuracion abierto
(Figura 23) y correspondiente al método
de interpolacion, se le asignan los datos
necesarios, con la finalidad de obtener el
raster de la precipitacibn media anual
para el periodo de registro 1953 - 2010
(Figura 24).

#, Kriging - [m] x

Input point features ~
[ Estaciones_Met_1851-2010 =l &
2 value field

stacdr] [v
Shape.Z

Estacidn
X

¥
Altitud
Fot_1

OK Cancel Environments... Show Help =>

Figura 23. Menu de configuracion del Kriging.

X

Figura 24. Mapa de interpolacion Kriging para la
distribucion de la precipitacion.

Realizado el proceso anterior, fue
necesario seguir la ruta ArcToolBox >
Spatial Analyst Tools > Map Algebra >
Raster Calculator (Figura 25) la cual
permiti6 acceder a la aplicacion de la
férmula asociada a la Region | de la
metodologia propuesta por Cortés

(1991).

. ArcToolbox ox
i

- @ @ Editing Tools ~
& Geocoding Tools

& Geostatistical Analyst Tools

B3 Linear Referencing Tools
& Multidimension Tools
& Network Analyst Tools
&9 Parcel Fabric Tools
& Schematics Tools
& server Tools
E} Space Time Pattern Mining Tools
=1 & Spatial Analyst Tools
& Conditional
& Density
18 Distance
£ » Extraction
+ Generalization

Groundwater
& Hydrology
& Interpolation
& Local
= & Map Algebra
~
& Math
& Multivariate
& Neighberhood

Figura 25. Localizacion de la herramienta Raster
Calculator.
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Finalmente, en el cuadro de datos de la  ANEXO 2
funcion Raster Calculator fue necesario Factor K
indicar la formula a aplicar, asi como la Con ayuda del conjunto de datos
direccion y nombre de guardado  del vectoriales, escala 1.250,000, serie Il
raster resultante (Figura 26). (continuo nacional) del INEGI (2014), se
Y de esta manera se obtuvo el archivo obtuvieron las unidades de suelo
tipo raster del factor R de Santiago presentes en Santiago Tulantepec. Para
Tulantepec (Figura 27). ello fue necesario aplicar la ruta

Geoprocessing > Clip (Figura 28).

,\Q Raster Calculator

Map Algebra expression

Layers and variables Conditional A Geoprocessing | Customize  Winc

<>krig\ng Con "\ Buffer

Pick. =

4[5 |l s& =[5 [[5=][ ) || sethu Y Clip |
s

Math

i G | I | | P Clip

Exp

Intersect

v Geoprocessing tool that extracts
input features that overlay the clij
(1.20785 * "kriging”) + (0.002276 * Square("kriging")) ‘ features,

ArcToolbox

Output raster
[ c:\A1_santiage Tpec_Nuevo Proyecto\Factor R\Factor |

Environments...

Results
ModelBuilder
Python

0% A

oK Cancel Environments. .. << Hide Help

Geoprocessing Options...

Figura 26. Men de configuracion de Raster Figura 28. Localizacién de la herramienta Clip.

Calculator para el calculo del factor R. _
Se procedi6é al llenado del cuadro de

didlogo (Figura 29) con los datos

necesarios.

#, Clip - O X
Input Features
| edaz51mew A=
Clip Features
[Eantiago Toec B
Output Feature Class
[ c:\sersth piDocuments\arcGIs \Default. gdb \eda 25 1mew_Clip =]
X Tolerance {optional)
[ Meters w

Figura 27. Raster de distribucion del factor R para o P e—— ————

Santiago Tulantepec.
Figura 29. Menu Clip para unidades de suelo.




Y asi obtener el poligono de Santiago
Tulantepec segun la distribucién de sus

unidades de suelo presentes (Figura 30).

Figura 30. Mapa de distribucion de las unidades de
suelo en Santiago Tpec.

Con la finalidad de ubicar puntos de
referencia para la obtencién de muestras
de suelo, se gener6 una malla de puntos
al seguir los pasos que se indican a

continuacion:

Al poligono de representativo de
Santiago Tulantepec se le aplico la
funcién que comprende la siguiente ruta:
ArcToolbox > Data Managenment
Tools > Sampling > Create Fishnet

(Figura 31).

Arcloolbox U x

&3 Data Interoperability Tools ~
= &§ Data Management Tools

& Archiving

B Attachments

& Data Comparison

& Distributed Geodatabase

& Domains

% Feature Class

B Features

B Fields

&y File Geodatabase

& General

B Generalization

ﬁ Geodatabase Administration

& Geometric Network

& Graph

& Indexes

& Joins

B LAS Dataset

& Layers and Table Views

& Package

& Photos

& Projections and Transformations

& Raster

& Relationship Classes

= & Sampling

’\ Create Fishnet

Figura 31. Localizacién de la herramienta Create
Fishnet.

De esta manera, al cuadro de dialogo se
le indicaron las caracteristicas
necesarias y lograr obtener los puntos

segun sus coordenadas UTM (Figura 32).

#, Create Fishnet - O X

[ C:Wusersth pipocuments\ArcGIS \Pefault. gdb\Puntos de Muestrea | A

Template Extent (optional)

Same as layer Santiago Tpec =]

Top
2220534, 573368
Left Right
555052.440398 569802.382898
Bottom
2210311.602765 Clear
Fishnet Origin Coordinate
X Coordinate Y Coordinate
555052.4403955946 ‘ 2210311.602765424|
¥-Axis Coordinate
X Coordinate Y Coordinate
555052.4403955946 ‘ 2210321.602765424|
@ Cell Size Width
o]
% Cell Size Height
Cancel Environments... || Show Help >

Figura 32. Menu Create Fishnet para generar puntos
de muestreo.

Asi se permiti6 obtener los puntos de
referencia para el muestreo en campo de
suelo con fines de actualizacion de la
textura de los suelos presentes (Figura
33).
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Figura 33. Malla de puntos de referencia para
muestreo.

Método de Bouyoucos

Una vez obtenidas las muestras de suelo
para cada sitio de muestreo se procedid
a determinar la clase textural para cada
una, para lo cual se aplicé el método de
Bouyoucos y de acuerdo a la NOM-021-
RECNAT-2000 fue necesario seguir los

pasos que a continuacion se enlistan:

e Se pesan 50 g de suelo seco y

colocarlos en un vaso de
precipitados de 250 ml. Adicionar
agua destilada hasta cubrir la
superficie con una lamina de 2 cm.
Agregar 5 ml de oxalato de sodio y
5 ml de metasilicato de sodio y

dejar reposar durante 15 minutos.

e A continuacién, pasar la muestra
del vaso de precipitado a la copa

del agitador mecanico, pasando

todo el material con la ayuda de
una piceta. Encender el agitador y
proceder a dispersar durante 5
minutos. Al finalizar el tiempo de
agitacion, transvasar el contenido
a una probeta de 1000 ml,
enjuagando la copa con ayuda de

una piceta.

e Posteriormente es necesario
agregar agua destilada con la
finalidad de aforar a un litro con el
hidrémetro dentro de la
suspension. Sacar el hidrometro y
suelo

suspender el con un

agitador de mano operando

durante un minuto.

¢ Finalmente, tomar las lecturas del
hidrébmetro a los 40 segundos y
después de 2 horas de terminada
la dispersion con el agitador de

mano.

Es recomendable para hacer una lectura,
colocar el hidrémetro dentro de la probeta
20 segundos antes del momento de la
determinacion, cuidando de alterar en lo
mas minimo posible la suspension.
Después de hacer la lectura se seca el
hidrometro, se lava, se seca y se toma la
temperatura. Si por alguna razon al

realizar la lectura se acumula espuma



alrededor del hidrémetro, agregar unas

gotas de alcohol etilico.

Para realizar los céalculos asociados a la
determinacion de la textura del suelo es
necesario corregir las lecturas del
hidrobmetro agregando 0.36 por cada
grado centigrado arriba de 195 vy
viceversa. La lectura a los 40 segundos
multiplicada por 2 es igual al porcentaje
de arcilla mas limo y restando a 100, se
obtiene el porcentaje de arena. La lectura
obtenida a 2 horas multiplicada por 2 es
igual al porcentaje de arcilla y el
porcentaje de Ilimo se obtiene por
diferencia.

Cuando se usan 100 g de suelo no debe
multiplicarse por 2, ya que el hidrémetro
esta calibrado en porcentajes
considerando 100 g de suelo. Con los
porcentajes de limo arcilla y arena se
determina la textura correspondiente al

triangulo de texturas.

Una vez realizado el procedimiento
anterior, se obtuvieron los datos que se
muestran a continuacion (Tabla 19) para

cada sitio de muestreo:



Tabla 19. Valores obtenidos durante la aplicacion del método de Bouyoucos para cada sitio de muestreo.

Lectura Hidrometro Lectura Termémetro (°C)

Porcentaje de particulas

No. Sitio Tridngulo de texturas  Textura
40 s 2h 40 s 2h % Arcilla % Limo % Arena
1 25 11 26 26 26 28 46 Franco arcillo arenosa  Media
2 28 14 25.5 26 32 28 40 Franco arcillosa Media
3 30 19 25.5 26 38 26 36 Franco arcillosa Media
4 27 11 25.5 26 26 32 42 Franca Media
5 28 12 25.5 26 28 32 40 Franco arcillosa Media
66R 2; 12 222 22 36 32 32 Franco arcillosa Media
7 35 21 25.5 26 46 28 26 Arcillosa Fina
8 30 15 25 25 34 30 36 Franco arcillosa Media
9 32 18 25 25 40 28 32 Franco arcillosa Fina
10 37 24 25 25 52 26 22 Arcillosa Fina
11 24 11 25 25 26 26 48 Franco arcillo arenosa Media
1122R 2; i; ;g ;g 38 30 32 Franco arcillosa Media
13 32 17 26 25 38 30 32 Franco arcillosa Media
14 38 23 26 25 50 31 19 Arcillosa Fina
15 29 13 26 25 29 33 38 Franco arcillosa Media
16 26 10 26 25 23 33 44 Franca Media
17 24 14 26 25 32 20 48 Franco arcillo arenosa  Media
118?? ;g g 22 22 22 21 57 Franco arcillo arenosa  Media
19 29 18 24 25 40 21 39 Franco arcillosa Fina
20 31 20 23 24 43 21 36 Arcillosa Fina
21 29 19 24 25 42 17 41 Arcillosa Fina
22 24 13 24 25 30 21 49 Franco arcillo arenosa  Media
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Una vez aplicado el método de
Bouyoucos a cada una de las muestras
obtenidas durante el muestreo y la
determinacion de la textura de cada
unidad de suelo, se actualizaron vy
asignaron los valores de K en la tabla de
datos del archivo vectorial trabajado

(Figura 34).

Table

SRR

Unidades y subunidades de suelo

FID Shape * AREA PERIMETER DESCRIPCIO Factor_K

5 [Polygon 764430691 14.489951 | CAMBISOL HUMICO 0.02
& | Polygon 1.514285 0.758514 |FEOZEM HAPLICO 0.02
4 |Polygon 568.821037 13.287083 |FEOZEM LUVICO 0.02
2|Polygon 113460682 7.732075 |LMOS0L 0.013
1 |Polygon 3310.355831 45574482 | LUVISOL CROMICO 0.04
3 |Polygon 822573685 25.185372 |LUVISOL ORTICO 0.04
0 [Polygon 843411183 20.841103 | VERTISOL PELICO 0.079

Figura 34. Tabla de datos del archivo vectorial del
factor K.

Para finalizar el célculo del factor K, fue
necesario seguir la ruta: ArcToolbox >
Conversion Tools > To Raster >
Feature to Raster (Figura 35) y poder
realizar las configuraciones necesarias

(Figura 36).

ArcToolbox o x

Q 3D Analyst Tools A
@@ Analysis Tools
&3 Cartography Tools
=] Q Conversion Tools
& Fxcel
& From GRS
p From KML
3 From PDF

s From Raster
& From WFS

& JsoN

8 Metadata

3 To CAD

¢ To Cellada

7 B To Coverage

& To dBASE

& To Geodatabase
8 To GeoPackage
B To KML

= & To Raster

#, ASCll to Raster
#., DEM to Raster

BN Feature to Raster

#. Flnat tn Raster

Figura 35. Localizacién de la herramienta Feature to
Raster.

#, Feature to Raster

Input features

[Unidades y subunidades de suela =1 &

Field

[ Factor & v

Output raster

[ €:\41_Santiago Toec_Nueva Provecto Factor K_Actualizado25-09\Fact K =]

Qutput cell size (optional)

[l ] e
OK Cancel Environment its... << Hide Help

Figura 36.Configuraciones de la herramienta Feature
to Raster.

Y asi fue como se logré obtener el raster

de distribucion del factor K. (Figura 37).

.
ol

Figura 37. Raster de distribucion del factor K en
Santiago Tulantepec.

ANEXO 3
Factor LS

Para obtener el factor LS fue necesario
contar con el Continuo de Elevaciones
Mexicano version 3.0 del INEGI, el cual
tiene una distancia entre pixeles de 15 m.
CEM 3.0 de

referencia, se procedioé a aplicar la ruta

Una vez teniendo el

siguiente:  ArcToolBox > Spatial

Analyst Tools > Extraction > Extract by
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Mask, con la finalidad de obtener el

raster correspondiente al area de estudio

(Figura 38).
ArcToolbox O x
E) Geostatistical Analyst Tools ~

@ Linear Referencing Tools
&3 Multidimension Tools
B Network Analyst Tools
@ Parcel Fabric Tools
@ Schematics Tools
@ Server Tools
g’ Space Time Pattern Mining Tools
=] @ Spatial Analyst Tools
& Conditional
& Density
& Distance
= & Extraction
"g Extract by Attributes
#%, Extract by Circle
« R
Ix Extract by Points
#,, Extract by Polygon

Figura 38. Localizacién de la herramienta Extract by
Mask.

Una vez asignadas las referencias para
la obtencién especifica del area de
estudio (Figura 39), se permitié obtener el
poligono de referencia y de trabajo
referente a las elevaciones presentes en

Santiago Tulantepec (Figura 40).

v
| %, Extract by Mask

Input raster
[cem =
Input raster or feature mask data
[Santiage Tpee_UTM =
‘Output raster §
C:LS15m_AreGISPro_ChadiMDE_Sant15m | E
oK Cancel Environments. << Hide Help

Figura 39. Configuracién de la herramienta Extract by
Mask.

Figura 40. Raster de elevaciones de Santiago
Tulantepec.

Teniendo el raster de elevaciones del
poligono del municipio y aplicando la
metodologia del factor LS, de manera
inicial fue necesario aplicarle la
herramienta Fill que se encontré en la
ruta ArcToolbox > Spatial Analyst
Tools > Hydrology > Fill (Figura 41) y
sus configuraciones necesarias (Figura
42) para obtener el raster de elevaciones
sin errores de llenado de pixeles (Figura

43).

ArcToolbox o x

&) Dats Management Tools ~
&3 Editing Tools
@ Geocoding Tools
@ Geostatistical Analyst Tools
&3 Linear Referencing Tools
@ Multidimension Tools
@ Network Analyst Tools
@ Parcel Fabric Teols
@ Schematics Tools
@ Server Tools
g’ Space Time Pattern Mining Tools
= @ Spatial Analyst Tools

% Conditional

&y Density

&y Distance

&y Extraction

& Generalization

% Groundwater

= & Hydrology

"ﬁ Basin

¥l

Figura 41. Localizacién de la herramienta Fill.




1% Fil
Input surface raster
[ mdets_st_mask Bl
Output surface raster
[ c:\515m_ArcGISPro_ChadiVFil_15Msan |
Z limit: (optional)
oK Cancel Environments... =< Hide Help

Figura 42. Configuracion de la herramienta Fill.

Figura 43. Raster resultante de la herramienta Fill.

A continuacion, al raster resultante
anterior, se le aplicé la herramienta Flow
Direction, encontrado en ArcToolbox >
Spatial Analyst Tools > Hydrology >
Flow Direction (Figura 44) y sus
configuraciones necesarias (Figura 45)
que permitieron obtener la direccion de

flujo del municipio (Figura 46).

ArcToolbox (mi

BJ Geostatistical Analyst Tools N
&) Linear Referencing Tools
@ Multidimension Tools
@ MNetwork Analyst Tools
B3 Parcel Fabric Tools
&3 Schematics Tools
@ Server Tools
E3 Space Time Pattern Mining Tools
= B3 Spatial Analyst Tools
& Conditional
& Density
& Distance
& Extraction
& Generalization
& Groundwater
= & Hydrology

#,, Basin
#, Fill
#, Flow Accumulation
-
Figura 44. Localizacion de la herramienta Flow
Direction.
., Flow Direction
Input surface raster
[fill_15msant | |
Output flow direction raster
[ c:\s15m_ArcGISPro_ChadiFlowD_1smsan |

[ Force all edge cells to flow outward {optional)

Output drop raster (optional)

o

\ | &

Flow direction type (optional)

[ome |
oK Cancel | |Environments... | | << Hide Help

Figura 45. Configuracién de la herramienta Flow
Direction.

Figura 46. Raster de direccion de flujo de Santiago
Tulantepec.

Posteriormente, al raster obtenido en el
proceso anterior, se le aplico la
herramienta Flow Accumulation que se

encontré siguiendo la ruta ArcToolbox >



Spatial Analyst Tools > Hydrology >
Flow Accumulation (Figura 47) y sus
configuraciones necesarias (Figura 48)
que permitieron obtener la acumulacion
de flujo de Santiago Tulantepec (Figura

49).

ArcToolbox o x

+# B Geostatistical Analyst Tools ~
% @ Linear Referencing Tools
£ @ Multidimension Tools
£ @ MNetwork Analyst Tools
3 @ Parcel Fabric Tools
E3 @ Schematics Tools
1 B Server Tools
&3 Q Space Time Pattern Mining Tools
= @B Spatial Analyst Tools
| & Conditional
] By Density
3 & Distance
+ & Extraction
+ & Generalization
+ & Groundwater
= & Hydrology
"r-\\ Basin
#, Fill
’% Flow Accumulation

"-\\ Flow Direction

Figura 47. Localizacion de la herramienta Flow
Accumulation.

X Flow Accumulation
Input fiow direction raster
[flowd_15msant =~ &
Output accumulation raster
[ C:\515m_ArcGIsPro_Chadi\Flowa-15mSan |
Input weight raster (optional)
=]

Output data type (optional)
[FLoaT ]
Flow drection type (optional)
G M

oK Cancel | Environments... | <<Hide Help

Figura 48. Configuracion de la herramienta Flow
Accumulation.

Figura 49. Raster de distribucién de la acumulacion de
flujo.

De manera siguiente, fue necesario

obtener la pendiente del terreno, por ello
se tomo la ruta ArcToolbox > Spatial
Analyst Tools > Surface > Slope
(Figura 50).

ArcToalbox ox
& @ Server Tools -~
m &} Space Time Pattern Mining Tools
= @3 Spatial Analyst Tools

= & Conditional
) & Density
+ & Distance
) &y Extraction
) & Generalization
© & Groundwater
= & Hydrology
= & Interpolation
= & Local
) & Map Algebra
o & Math
= & Multivariate
5 & Neighborhood
& Overlay
+ @y Raster Creation
+ @y Reclass
+ & Segmentation and Classification
5 & Solar Radiation
5 & Surface

#, Aspect

, Contour

+, Contour List

v, Contour with Barriers
Curvature

. CutFill

. Hillshade

, Observer Points

N siope]

AN K NN RN

Figura 50. Localizacién de la herramienta Slope.

A la realizaron las

cual se le
configuraciones necesarias (Figura 51)
para poder obtener el raster de
distribucion de la pendiente, expresada

en grados (Figura 52).



#, Slope

Input raster

[fill_15msant = e
Outputraster

[ c:\515m_ArcGISPro_Chadi\lope_15msan |
Output measurement (optional)

| DEGREE ]
Method (optional)

[PLanaR
Az factor (optional)
\ dl
Z unit (optional)

METER

OK Cancel Environments. .. << Hide Help

Figura 51. Menu de configuracion de la herramienta
Slope.

Figura 52. Raster de distribucion de la pendiente en
grados para Santiago Tulantepec.

Una vez realizados los procesos
anteriores, se aplicaron las férmulas

relacionadas con la metodologia de
trabajo, que de manera inicial indicaron el
calculo del valor de 8, mediante la funcion
Raster Calculator (Figura 53) y que ya fue
explicada su localizacibn en procesos

anteriores.

#, Raster Calculator

Map Algebra expression

Layers and variables Fran =
<> fil_tsmeant Cos
msan
. 7 (8 (|9 ||/ |[==||t=|] &|fCosH
< slope_15msant e
> fowd_i5msant et
> flowa_15msant
> mde15_st_mask cFz s | - T [=|[=]| ™
mde15_st_mas =
Creem
0 [l =~ .

((Sin(slope_15msant™=0.01745)/0.0896)/(3Power(Sin(slope_15msant™=0.01745),0.8)+0.56))

Output raster
[ c:\s 15m_arcaispro_chadiFact |

o

Cancel Environments... << Hide Help

Figura 53. Calculo del valor de 8 mediante la
herramienta Raster Calculator.

Esto permiti6 la obtencion del raster de

distribucién de B para el municipio (Figura

54).

Figura 54. Raster de distribucion de 8 para Santiago
Tulantepec.

Después, se procedié a aplicar la formula
asociada para el calculo de m, mediante
la Raster Calculator (Figura 55).
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i, Raster Calculator

De esta manera, se estimo la distribucion

Map Algebra expression

et Condiional — del factor L para el poligono de Santiago
facth Con
> fil_15msant TlELE [0 | R .
G e snnibEEniE Tulantepec (Figura 58).
flowd_15msant Math
> flowa_15meant 1z 3 -l = s=] Ah:
>mde15_st_mask Ex
Oeem 02 | I | NS | i v
(facth™/("factb™+1)) ‘
Output raster ]
[CoU515m_Chad, 2016 Facth |
oK Cancel Environments... << Hide Help

Figura 55. Aplicacion de la formula asociada a m.
Del mismo modo, se obtuvo el raster de

distribucion de m para el area de estudio
(Figura 56).

Figura 58. Raster de distribucion del factor L en
Santiago Tulantepec.

De manera continua, se estimé el valor
del factor S a través de su formula
asociada y su aplicacibn en la
herramienta Raster Calculator (Figura
59).

Figura 56. Raster de distribucion de la variable m.

#, Raster Calculator

Ya obtenidos los raster de las variables 8 e et ceressin

Layers and variables ~ Con ~
y m, se realizé el calculo del factor L y la Sree anBinEEnES
Dty 41 5|6 =1l = ||>=| | ||sm
aplicacion de su férmula (Figura 57). §§JL;LT1?:ant e EEEE
flowd_15msant
<> flowa_15msant v 0 . O |~ v

. Raster Calculator

Con(Tan("slope_15msant” * 0.01745) < 0.03,(10.8 *5in{"slope_15msant” * 0.01745) +0.03),(16.8 =5in
("slope_15msant™ * 0.01745) - 0.5))

Map Algebra expression

Layers and variables ~ Mod ~ Output raster

Cactm Poner | c:\515m_Chadi, 2016\Factors |
Sacto 7la|leo||1]||=|=] &

act RoundDown
gﬁu_wmsant s s |[s![ =15 5211 ]| Roundun

slope_15msant Square
&> flowd_15msant 12|53 |- < <= * || squareRoat oK Cancel Environments.., | | << Hide Help
> flowa_15msant .

- 1| Tigonometric

Omdels st_mask v g . i § ) L

(Power(("flowa_15msant™+225),("factm™+1))-Power("flowa_15msant”, (factm™+1)))/(Power(15, Flgura 59 EStImaCIOn del faCtor S mEdIante la RaSter
(“Factm"+2))*Power(22. 13, Factm )| Calculator.

Output raster

[cksio o o 3= Lo que permiti6 obtener su distribucion
- 1@ = dentro del poligono del municipio de
Figura 57. Célculo del factor L mediante la Raster Santiago Tulantepec (Figura 60).

Calculator y su férmula asociada.



Figura 60. Réaster de distribucion del factor S para
Santiago Tulantepec.

Finalmente, obtenidos los raster de
distribucion del factor L y S, fue necesario
su céalculo de manera conjunta mediante
la herramienta Raster Calculator (Figura
61) y asi obtener el factor LS distribuido

en Santiago Tulantepec (Figura 62).

£, Raster Calculator
Map Algebra expression
Layers and variables Conditional — A
O factors o [ s e
O factorl == Pick
&> factm alzlc 5> |[5=][ ] || et
Orfacth Math
gﬁILISrnsant 1[2]s < [le= s
slope_15msant
— Exp
{flowd_15msant © G | RS [ ) v
“factorl” * “factors” |
Output raster
[ c:\L515m_Chadi 2016 \Factorts |
oK. Cancel Environments... << Hide Help

Figura 61. Calculo del factor LS para el municipio.

Figura 62. Raster de distribucion del factor LS de
Santiago Tulantepec.

ANEXO 4
Factor C

Mediante el uso de imagenes satelitales
y el poligono de referencia de Santiago
Tulantepec, se realiz6 una clasificacion
de superficies, de acuerdo a su uso de
suelo y vegetacion.

Para ello fue necesario la generacion de
poligonales segun los diferentes usos de
suelo y vegetacion encontrados en el

area de estudio (Figura 63).

Figura 63. Poligonos de corte para los diferentes usos
de suelo y vegetacion.

Una vez determinadas las areas y su

analisis, se asignaron los valores
y que

adaptaron a la realidad del factor C, a

correspondientes mejor se

través de su tabla de atributos (Figura
64).

Teble o %
ERIE- AL
Veg_2021_Sant *

FID | Shape * Veg_2021 Area_| Factor C ~
7944306 0.03
594 | Polygon 13.376874 0.03

2|Polygon 240477809 1
1Polygen 18413739 0.001
792[Polygon | Corriente de agua 0588756 0.08 v

"o« 1 v [E]= (©out of 1207 Selected)

365 | Polygon

Figura 64. Asignacion de valores de C a la tabla
asociada a los poligonos de usos de suelo y
vegetacion.



Continuamente, se siguid la ruta
ArcToolbox > Convesion Tools > To
Raster > Feature to Raster (Figura 65) y
sus configuraciones necesarias (Figura
66), con la finalidad de convertir el
archivo de poligonos a un formato raster
referente al factor C y su distribucién
(Figura 67).

ox

Figura 65. Localizacién de la herramienta Feature to
Raster.

#, Feature to Raster

Input features

[Veg_2021_sant =]
Field

[Factor ¢ |
Qutput raster

[(cx\A1_Santiago Tec Nueve ProyectoFactor C\Raster C\Factor C_ |
Output cel size (optional)

[ =]

oK Cancel << Hide Help

Figura 66. Configuracion de la herramienta Feature to
Raster.

Figura 67. Distribucion del factor C en el municipio.

ANEXO 5

Factor P

Una vez clasificado el uso de suelo y
vegetacion en Santiago Tulantepec y
evaluada la posible presencia de
obras/précticas de conservacion de suelo
y agua, se asignaron los valores a la tabla

asociada segun P (Figura 68).

FID | Shape* Veg_2021 Area_ Factor_P ~

aiz 0419609 06|
0184781 06
2.638075 05
0677376 [
1592544 [
T R71041

6
T
&|Polygo
s
0

nnnnnnnn

"o 2 n(E

Veg 2021 Sarit

(0 out of 1210 Selected)

Figura 68. Asignacion de valores de P a la tabla
asociada.

Realizada la asignacion de valores de P,
fue necesario aplicar la ruta ArcToolbox
> Convesion Tools > To Raster >
Feature to Raster (Figura 69) y la
verificacion de sus configuraciones
necesarias (Figura 70) que permitieron el
procesamiento y obtencion de la
distribucién del factor P en Santiago

Tulantepec (Figura 71).

ox

Figura 69. Ruta de localizacion de Feature to Raster.




i, Feature to Raster

Input features

[Veg_2021_Sant - &
Field

e ? -
Output raster

[ c2\a1_santiago Tpec_Muevo Proyecto\Factor P\alores Factor PFactor P_Raster Factor P =
Qutput cell size (eptional)

[ =

ok Cancel | [Environmen s, << Hide Help

Figura 70. Pestafia de configuracion de la herramienta
Feature to Raster.

Figura 71. Distribucion del factor P en Santiago Tpec.

ANEXO 6

Erosiéon Hidrica Actual

Para realizar el célculo de la erosion
hidrica actual y de acuerdo a su férmula
asociada, fue necesario el uso de la
herramienta Raster Calculator (Figura
72), la cual permitié la estimacion de la
distribucion actual de la erosion,
expresada mediante un archivo tipo

raster (Figura 73).

#, Raster Calculator

Map Algebra expression

Layers and variables Conditional ~

> factorr el 5 o] e
{yFactor K. Hl=== Pick
> Factorls a5 [ = [ |[o= ][ ]| setut
< factor ¢ Math
< Factor P 123 < |« s
0 Al ]| ~ 5*91 R v

“factorr™ = Factor K" * Factorls” = “factor_c** Factor P" ‘

Output raster
[ Ci\A1_Santiago Tpec Nuevo ProvectolErosion Hidrica ActualRaster_Erosidn Actual \ErosionActual | Iél

oK Cancel Environmen ts... << Hide Help

Figura 72. Aplicacion de la formula de erosion hidrica
actual en la Raster Calculator.

Figura 73. Distribucion de la erosion hidrica actual en
Santiago Tulantepec.

ANEXO 7

Erosién Hidrica Potencial

En el calculo de la erosion hidrica
potencial, fue necesario solo tomar en
cuenta los factores R, K y LS, esto de
acuerdo con la férmula asociada para su
determinacién, lo cual fue posible
mediante su aplicacién en la herramienta

Raster Calculator (Figura 74).
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#, Raster Calculator

Map Algebra expression

Layers and variables
<>factorr
> factor_k
CrFactorls

Conditicnal ~

Con
Pick.
Sethull
Math
Abs
Exp

v

"factorr™ * "factor k" * FactorLS"

Output raster

[ c:\A1_Santiage Tpec_Nuevo Proyecto\Erosion Hidrica Patendal\ErosianPaten

Cancel

Environments. ..

| El

<< Hide Help

Figura 74. Calculo de la erosion hidrica potencial
mediante la Raster Calculator.

Y de este modo, se obtuvo el mapa de

distribucion
potencial
(Figura 75).

erosion

hidrica

para Santiago Tulantepec

Figura 75. Distribucion de la erosion hidrica potencial

en el area de estudio.
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